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Praise for The Official Ubuntu Book

“The Official Ubuntu Book is a great way to get you started with Ubuntu,
giving you enough information to be productive without overloading you.”

—John Stevenson, DZone Book Reviewer

“OUB is one of the best books I’ve seen for beginners.”

—Bill Blinn, TechByter Worldwide

“This book is the perfect companion for users new to Linux and Ubuntu.
It covers the basics in a concise and well-organized manner. General use
is covered separately from troubleshooting and error-handling, making
the book well-suited both for the beginner as well as the user that needs
extended help.”

—Thomas Petrucha, Austria Ubuntu User Group

“I have recommended this book to several users who I instruct regularly on
the use of Ubuntu. All of them have been satisfied with their purchase and
have even been able to use it to help them in their journey along the way.”

—Chris Crisafulli, Ubuntu LoCo Council, 
Florida Local Community Team

“This text demystifies a very powerful Linux operating system . . . in just a
few weeks of having it, I’ve used it as a quick reference a half dozen times,
which saved me the time I would have spent scouring the Ubuntu forums
online.”

—Darren Frey, Member, Houston Local User Group
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AS WE WRITE THIS, it has been several years since we penned the first edition
of The Official Ubuntu Book. Over that time, we have seen Ubuntu continue
its explosive growth. Updating this book drives this fact home in striking
ways. For example, the number of users and posts in the Ubuntu Forums
has nearly doubled since the last edition of this book a year ago. Again. The
number of officially supported flavors of Ubuntu has increased as well.
Again. Once again, we feel blessed that The Official Ubuntu Book has been
able to benefit from, and perhaps in a small way even contribute to, that suc-
cess. Ultimately, that success paved the way for several subsequent editions,
and now the sixth edition, of the book that you’re reading now.

In the process, this book, like Ubuntu, continues to mature. Our job as
authors, like that of the Ubuntu developers, now involves more updating
and polishing than it used to. Distributed under a free license, a once-risky
book on a once-risky operating system is, just a few short years later, as
close to a sure thing as an author, publisher, and if we have done our job
well, a reader, could hope for.

And yet with success comes responsibility to our readers and to our users
with high expectations. Ubuntu’s success is built in part of maturity and
excellence, and it cannot sacrifice these qualities if it will succeed. We can-
not either. Our job as writers is complicated because we need to accurately
reflect and represent both while catering to an increasing and increasingly
diverse group of users.

As we’ve noted in the prefaces to previous editions of this book, being
Official has carried with it a set of rights and responsibilities. Our book’s
title means that we must attempt to reflect and represent the whole Ubuntu
community. While we, as authors, are expected to put ourselves into the
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book, it is understood that it can never be to the detriment of the values,
principles, technologies, or structures of the Ubuntu community.

Doing this has been complicated as Ubuntu has grown. In each edition, we
have added new information, because the Ubuntu community has grown
to include new projects. In each revision of this book, we have needed to
add to the list of related projects, tools, and community initiatives. As the
Ubuntu community grows, it is impossible to give a complete accounting
of what Ubuntu has to offer. Creating a summary requires some hard deci-
sions. At the end of the day, we are constrained by page count and our own
limited schedules.

Meanwhile, as with earlier editions, we needed to write this book about a
new release of Ubuntu while that version was under active development
and was being redesigned, rethought, and rebuilt. Every day, Ubuntu grows
in different, unpredictable ways, and this growth has increased exponen-
tially with the size of the community and the diversity of the userbase. Our
book’s development process had to both match and track this process as
our content was crafted, rewritten, adjusted, and allowed to mature itself.

As in the previous edition, the contributors to this book go well beyond
those listed on the book’s cover. Invisible to most readers, dozens of mem-
bers of the community left their mark on different parts of the text of this
book. Although this degree of participation led to a writing process that
was as hectic, and at times frustrating, as the process that builds Ubuntu,
we hope we can remind readers of the level of quality that this process
inspires in our book’s subject. In the places where we achieve this, we have
earned our book’s title. With that goal in mind, we look forward to future
versions of Ubuntu and editions of this book wrought through the same
community-driven process.

xxx Preface
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WELCOME to The Official Ubuntu Book, Sixth Edition!

In recent years, the Ubuntu operating system has taken the open source
and IT world by storm. From out of nowhere, the Little Operating System
That Could has blossomed into a full-featured desktop and server offering
that has won over the hearts of users everywhere. Aside from the strong
technical platform and impressive commitment to quality, Ubuntu also
enjoys success because of its sprawling community of enthusiastic users
who have helped to support, document, and test every millimeter of the
Ubuntu landscape.

In your hands you are holding the official, authorized guide to this impres-
sive operating system. Each of the authors selected to work on this book
has demonstrated a high level of technical competence, an unbridled com-
mitment to Ubuntu, and the ability to share this knowledge in a simple
and clear manner. These authors gathered together to create a book that
offers a solid grounding to Ubuntu and explains how the many facets and
features of Ubuntu work.

About This Book
At the start of every book, on every bookshelf, in every shop, is a para-
graph that sums up the intentions and aims for the book. We have one
very simple, down-to-earth aim: to make the Ubuntu experience even
more pleasant for users. The Ubuntu developers and community have
gone to great lengths to produce an easy-to-use, functional, and flexible
operating system for doing, browsing, and creating all kinds of interesting
things. This book augments that effort. With such an integrated and flex-
ible operating system, this guide acts as a tour de force for the many things
you can do with Ubuntu.



The Scope of the Book
With so much to cover, we had our work cut out to write a book that could
cover the system in sufficient detail. However, if we were to write in depth
about every possible feature in Ubuntu, you would need to buy a new
bookcase to store the sheer amount of content.

Part of the challenge in creating The Official Ubuntu Book was selecting the
topics and content that can be covered within a reasonably sized book. We
have identified the most essential content and written only about it. These
chosen topics not only include installation, use of the desktop, applications,
multimedia, system administration, and software management, but also
include a discussion of the community, online resources, and the philoso-
phy behind Ubuntu and open source software. As a bonus, we expanded
our discussion of projects related to Ubuntu that will be of interest to you.
We believe this book provides an ideal one-stop shop for getting started
with Ubuntu.

The Menu
Here is a short introduction to each chapter and what it covers.

� Chapter 1—The Ubuntu Story: This spirited introduction describes
the Ubuntu project, its distribution, its development processes, and
some of the history that made it all possible.

� Chapter 2—Installing Ubuntu: We walk through the installation
process one step at a time to clearly describe how anyone interested
may begin using Ubuntu on their own computer.

� Chapter 3—Using Ubuntu on the Desktop: This is an informative and
enjoyable introductory tour of the Ubuntu desktop, the applications
included, and ways to configure and customize your desktop.

� Chapter 4—Gaining Greater Proficiency: We explore some of the
advanced ways to use Ubuntu, including managing the system. These
features are not vital if you want to use the computer only as a simple
tool, but once you learn how to install and manage software, use
hardware devices and printers, interact with remote computers, use
the terminal, and run some Windows programs under Ubuntu, you
will find your overall experience even more rewarding and enjoyable. 
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� Chapter 5—The Ubuntu Server: This introduction to Ubuntu Server
installation and administration includes coverage of command-line
package management, basic security topics, and advanced installer
features like logical volume management and RAID.

� Chapter 6—More Applications for Ubuntu: Here we discuss some 
of the most interesting and useful options from among the software
packages available for Ubuntu but not installed by default. These
quality programs are interesting and useful, but either there is not
enough space to include them on the installation CD or they are
without as wide an audience as those programs preinstalled for
everyone.

� Chapter 7—The Ubuntu Community: The Ubuntu community is
larger and more active than many people realize. We discuss many 
of its facets, including what people like you do to build, promote,
distribute, support, document, translate, and advocate Ubuntu—and
we tell you how you can join in the fun.

� Chapter 8—Using Kubuntu: The most popular spin-off project from
Ubuntu is Kubuntu. This chapter provides a solid introduction and
primer for getting started.

� Chapter 9—GNOME 3, GNOME Shell, and More: The default
graphical user interface for Ubuntu is Unity, discussed throughout this
book. Another option is KDE, discussed in Chapter 8. In Chapter 9, we
introduce other options for those who like to customize or experi-
ment or who have unique needs.

� Chapter 10—Ubuntu-Related Projects: There are a number of Linux
distributions based on Ubuntu that you will find interesting and
possibly useful. We discuss some of these as well as projects that are
integral to the creation of Ubuntu, such as Launchpad and Bazaar.

� Chapter 11—Introducing Ubuntu One: Ubuntu One is a cloud
storage option that integrates perfectly into the Ubuntu desktop. A
free version is provided by Canonical, with extra features available 
for a fee.

� Appendix—Welcome to the Command Line: You can begin to take
advantage of the power and efficiency of the command line with the
clear, easy-to-use examples in our brief introduction.
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The Ubuntu team offers several installation options for Ubuntu users,
including CDs for desktop, alternate install, and server install. These three
CD images are conveniently combined onto one DVD included in the
back of this book, allowing you to install Ubuntu for different configura-
tions from just one disk. There is also an option to test the DVD for defects
as well as a memory test option to check your computer.

The first boot option on the DVD, Start or Install Ubuntu, will cover most
users’ needs. For more comprehensive information, check the Help feature
by selecting F1 on the boot menu. You can also refer to Chapter 2, which
covers the Ubuntu installation process in detail.

You can find the DVD image, the individual CD images (for those who
don’t have a DVD drive), and Kubuntu and Ubuntu Server on www.ubuntu.
com/download.
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WITH UBUNTU INSTALLED and ready to go, it’s time to get started using your
new desktop. The stock install of Ubuntu provides a very complete and
flexible system. Unlike other operating systems, such as Microsoft Win-
dows or Mac OS X, Ubuntu includes everything you need to get started: an
office suite, media tools, a Web browser, an e-mail client, and more. Once
the installation is complete, you are up and running right away without
having to install any additional software. Different people use their com-
puters in different ways, and every user has her own personal preference
for look and feel. Recognizing this desire, Linux has the capability to use
any one of a number of different graphical interfaces. This flexibility, com-
bined with the ballooning popularity of Linux and open source, has
resulted in literally hundreds of different graphical environments spring-
ing up, each covering these different types of users and ways of working.

Even though there is a huge range of different environments available, there
are two clear leaders in KDE and GNOME. Each environment provides a
good-looking, comprehensive, and easy-to-use desktop, but they differ in
how that desktop is used as well as in how further personalization can take
place. The KDE system aims for complete control and configurability of the
desktop. Any desktop configuration options that exist are available to the
user, who has easy access and can change the behavior and look of almost
everything. The competing GNOME desktop takes inspiration from both
Windows and Mac OS X and sets a priority on simplicity and ease of use.
GNOME is also easy to customize, but the less common options are either
eliminated or well hidden to prevent user overload. Luckily, Ubuntu users
are blessed with the choice of either desktop, along with several others,
some of which are mentioned in Chapter 10. The default desktop in
Kubuntu is KDE. Kubuntu is covered in Chapter 8. Ubuntu used to use
GNOME as its default desktop. Even though it is no longer the default, the
new GNOME3 is an option and is covered in Chapter 9.

In this chapter, we help you get started with Unity, the default desktop for
Ubuntu, and show how you can use it to do the normal things you face
every day with your computer and a few not-so-normal things. This
includes opening and running applications, managing your files, adjusting
the look and feel, using applications, managing your media, and more.
Buckle up and get ready to take your shiny new desktop for a drive!
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TIP The Ubuntu Desktop Is Unity
When reading about Ubuntu, you may see terms like Unity and Ubuntu desktop used inter-
changeably. The Ubuntu community, with sponsorship from Canonical, has created the Unity
desktop as the next stage in graphical interface evolution. Time will tell if other Linux distri-
butions follow suit or if they choose to use one of the other existing options.

Taking Your Desktop for a Ride
When you start your Ubuntu system, you are presented with a list of users.
Once you select your username from the list by clicking it, you are asked
for a password to log in with. In the last chapter, you specified a user
account when installing the system, so use that to log in. First select your
username and press Enter, then your password and press Enter. Your pass-
word will appear as a series of *s. This is a security feature.

After a few seconds you will see the Ubuntu desktop appear. If you have a
video card that is able to handle Unity, your desktop will look like Figure 3-1.
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If your computer cannot run Unity, or if you choose Ubuntu Classic Desk-
top from the menu at the bottom of the login screen after clicking your user-
name and before entering your password, instead of the default Ubuntu
Desktop Edition, your desktop will look and behave as in previous Ubuntu
releases (Figure 3-2).

Ubuntu Classic Desktop
This chapter will focus on the Unity desktop after the following short
description of the Ubuntu Classic Desktop. Much of what is said under the
Unity sections will apply to both, but screenshots and general descriptions
will be derived from the default Unity desktop.

1. At the top of the screen is the panel. This bar contains the desktop
menu options and application shortcut icons on the left side in a
menu accessed using the Ubuntu logo as well as the notification area
on the right side. You use this bar to load applications and to see the
status of certain activities on your system. The panel is always visible
when you use your desktop.
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2. The large middle part of the screen, located under the panel, is the
desktop. This part of the screen is normally covered by the applica-
tions that you use, but you can also put icons and shortcuts on the
desktop, too.

3. The bottom part of the screen is called the taskbar. This area displays
a rectangle for each open application, just like in Windows.

Starting applications is simple. Just click on the Applications menu on the
left side of the panel, denoted by an Ubuntu logo. Inside this menu are a
number of submenus for different types of applications. Hover your
mouse over each category, and then click the application you want to load.
As an example, click on Ubuntu Logo > Games > Mahjongg. 

Unity Starts Here
You may have noticed that, unlike other operating systems, there are no
icons on either the Unity or Classic desktop. The reason for this is that
desktop icons typically get covered by applications, and, as such, you can’t
get at them.

TIP Device Icons
Although there are no application icons on the desktop, when you plug in USB devices such
as portable music players, keyring drives, or digital cameras, a device icon will appear on the
desktop.

Starting Applications and Finding Things
To start an application in Unity, click the Applications logo in the Launcher
at the left side of the desktop (Figure 3-3).

When applications are loaded, the window border has three buttons on the
top on the left-hand side:

� Left button (red button with a black X): This button closes the
application.

� Middle button (white button with a gray –): This minimizes the
application, taking it off of your screen, and puts it in the Launcher
for easy access when you need it again.
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� Right button (white button with a gray square): This is used to
maximize the window to take up the full desktop area. Not all
application windows use this button, so don’t be surprised if you
don’t see it for an application that has a small window.

Every application that is currently in use has an entry in the Launcher on
the left of the desktop. You can click these entries to minimize or restore
the application, and you can right-click to see some other options. 
Any menus with options that exist for a program currently in use in the
foreground will appear in the top panel of the desktop. When you switch
programs, the contents of the top panel will change accordingly. Hover
over the name of the program at the top of a screen for a list of menus to
appear. Click any one for a drop down list of options. 

NOTE Because this is a new interface, not all applications have been modified to take advantage of
the idea; some applications may retain a menu within the application’s window.

Figure 3-3 The Unity Launcher



Finding Your Files and Folders
When using your computer, you often need to save and open files and
folders, move them around, and perform other tasks. Click the Files &
Folders icon from the Launcher for simple access to your files and folders
or the File Manager icon to access files and folders across different parts of
your computer or a network. Here are some of the main folders you will
find by default:

� Home Folder: Your home folder is used to store the files and work for
each user who is logged in. This is the most important folder on the
system, and you can think of it as the equivalent of My Documents in
Windows—virtually everything you save lives here. Each user has a
separate home folder that is named after the user’s username.

� Desktop: The Desktop folder is inside your home folder and contains
files that visually appear on your desktop as icons. If you drag a file
onto your desktop, it will appear in the Desktop folder. Similarly,
moving a file out of this folder or deleting it will remove it from your
desktop.

� Documents: This is a folder inside your home folder that is intended
to contain word processing files and other documents you create.

� Downloads: This is a folder inside your home folder that is intended
to contain items you download from the internet.

� Music: This is a folder inside your home folder that is intended to
contain music files.

� Pictures: This is a folder inside your home folder that is intended to
contain image files.

� Public: This is a folder inside your home folder into which you can
place files you want other users on your system or network to be able
to access.

� Templates: This is a folder inside your home folder that is intended to
contain templates for applications like your word processor.

� Videos: This is a folder inside your home folder that is intended to
contain visual media files.
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� Network: This option accesses all networked and shared devices, such
as file servers or printers, that are available on your local network.
This is the equivalent of the Network Neighborhood or Network
Places in various versions of Windows.

� Connect to Server: This option is available in File Manager from
the File menu that is accessed by hovering over the words File
Manager at the top of the screen when the application is open. Click
this to run a wizard to create a connection to a network server. You
can use this to add an icon to the desktop that, when clicked,
provides a list of remote files in the desktop file manager. You can
then treat this window like any other file manager window and drag
files back and forth. This is really useful for copying files to and from
other computers.

� Search for Files: Click Files & Folders from the Launcher to open and
enter your search term(s) at the top of the window.

Configuring Your System
Click Applications from the Launcher and click the down arrow to the
right of the search box. Select System to list Applications that let you con-
figure and customize your system. Possibilities include:

� Broadcast Preferences: This changes settings related to social
applications.

� Keyboard: This is where you install other keyboard layouts,
languages, and adjust settings.

� Mouse: This is where you can adjust your mouse settings.

� Power Management: This is where you can adjust your power use
settings.

� Screensaver: This is where you can adjust the operation of your
screensaver.

� Time and Date: This is where you can adjust time and date settings,
including setting Ubuntu to automatically update these via the
internet.

66 Chapter 3 � Using Ubuntu on the Desktop



TIP Feel the Power
When you installed Ubuntu, you were asked for a username and password for the system.
That first user account (and its password) has access to not just your normal user account
but also the all-powerful Administration features. Therefore, when you access the menu
options while using this account and are asked for a password, just enter this user account’s
password to use those features.

This feature applies only to the user account created during installation. If you add other
users, you need to explicitly allow them access to Administration options.

Adding Additional Users
Many computers these days are used by more than one person. Rather than
forcing everyone to use the same desktop settings or making the computer
less secure by allowing everyone who uses it to have access to administrative
functions, it is easy and recommended to create an account for every per-
son who will use the computer. This allows each user to customize how the
computer works and looks without interfering with anyone else’s prefer-
ences, and it grants the administrator privileges that prevent others from
accessing functions that may affect everyone or even damage the installa-
tion if used incorrectly.

Click Applications from the Launcher and choose Users and Groups to
add a new user. In the dialog box that appears, there is a list of current
users. At the bottom of the list, select Add to create a new user account, as
in Figure 3-4.

A password is required to make changes to users and groups, and only
those users with administrative access are able to do so. You must now pro-
vide a name for the new user as well as a short name that will be used by
that user to log in. Click OK, and in the next dialog box, enter a password
for that user, confirm the password by entering it a second time, and click
OK again. Voila, our new user account is created. You may also have a pass-
word generated randomly or allow the user to log in without a password.
This last option is not generally a good idea but can be useful. For example,
if the users are small children who are not expected to perform administra-
tive tasks, the children could have an account that automatically logs in
at boot time, and the administrator would have an additional account,
accessed by a password, to perform changes and updates when necessary.
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Finally, now that the account is created, we may customize its settings.
Highlight the username in the list, and click the Change button at the right
next to Account Type for a speedy way to give the user administration
privileges. The Advanced Settings button from the lower right corner of
the dialog box may be used to set contact information for the user, change
the account’s user privileges (for example, giving access to administrative
and several other functions that are not available through the quick
change option), and even change the location of the account’s home direc-
tory. Be careful when using this power because an account can be damaged
or rendered inaccessible if things are not done properly.

The Notification Area
On the right-hand side of the top of the desktop is the notification area
and the clock. The notification area is similar to the Windows system tray
in that it provides a series of small icons that indicate something specific. A
good example of this is Network Manager, which looks after your network
connections—both wired and wireless—for you.

You can adjust the notification area items by right-clicking them to view a
context menu. Some icons (such as the volume control) allow you to left-
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click on them to view them. As an example, try clicking the little speaker
icon and adjusting the slider.

QUICK TIP Left-click the volume icon and select Sound Preferences to access a large number of sound
settings. These settings configure the speakers, microphone, line-in, any other sound card
inputs or outputs, and more.

Network Manager
Network Manager is a network interface created to help you manage your
network devices and connections and is accessed using the network man-
ager applet. The goal is to make networking “just work” easily and without
requiring users to know how to hand-configure the settings (although that
is still available for those who want to do so). A left-click of the mouse on
the applet shows you the dialog box and enables quick changes between
network types. It even provides an easy way to set up access through a vir-
tual private network (VPN), such as many of us are required to use to
securely access files from work or school. A right-click lets you enable or
disable both wired and wireless networking, enable or disable notifica-
tions, see information about your current connection, and edit connec-
tions quickly and easily (Figure 3-5).

The Clock
Next to the notification area is the clock. Click on the clock to view a calen-
dar. Later, when you use Evolution, items that are added to your calendar

Taking Your Desktop for a Ride 69

Figure 3-5 The Network Manager applet, right-clicked to show connections menu



appear in the clock applet too. Instead of opening up Evolution to find out
when your dentist appointment is, just click on the clock to see it immedi-
ately. More information about Evolution is contained later in this chapter.

QUICK TIP Customize your clock by right-clicking it and selecting Preferences.

The Launcher
The Launcher sits on the left of the screen. This icon bar is visible, except
when an open window covers it, and indicates which applications are cur-
rently open as well as showing icon links for several applications. If the
Launcher is hidden by a window, it will appear as soon as you move your
mouse cursor over the area. In addition to indicating open applications
and providing links to select applications, the Launcher also sneaks in a
few other handy little features.

A purple icon with four squares inside it is the Workplace Switcher. Click it
to show all of your desktop workspaces (it will also show you what is open
in each, which is convenient). Each of these is another screen in which you
can view an application. As an example, you may be using your Web
browser and e-mail client while talking to your friends in a chat client on
the first desktop and working on a document on the second desktop. You
can then just click each virtual desktop to switch to it to access your differ-
ent applications. Click the desktop you want to use. Essentially, this expands
the screen real estate you have available and creates an easy way to keep
many programs open without them blocking one another.

QUICK TIP You can switch between multiple applications in Ubuntu just like in Windows by pressing
Alt-Tab. When you press this key combination, a small window appears that can be used to
switch between active applications on the current Workspace.

Other icons included by default are Tomboy Notes, a note taking applica-
tion, Ubuntu One, cloud storage described in Chapter 11, and the Firefox
web browser. At the bottom of the Launcher is the trash. Files dragged onto
this icon or right-clicked and “moved to trash” are destined to be deleted.
To fully delete these files, right-click the trash and select Empty Trash.
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TIP Usability and the Ubuntu Desktop
Throughout the development of the Ubuntu desktop, great care and attention have gone into
usability. As an example, the four corners of the screen are established as areas that are
simple to access—you don’t need to carefully mouse over the area and can instead just
throw your mouse to the corner. This is why each corner has an important feature. It makes
accessing each feature that little bit easier.

Ubuntu is filled with tiny usability improvements such as this that help make it as intuitive
and powerful as possible. Canonical has created a collective project called Ayatana to
spearhead this development, which has already produced the lovely indicator applet and is
working on greater refinements and features. More on Ayatana can be found at https://
wiki.ubuntu.com/Ayatana.

Shutting Down Your Computer and Logging Out
Now that you’re becoming acquainted with Ubuntu, you’ll want to keep
using it as long as possible, but there will always come a time when you have
no choice but to leave your computer and go do something else. As you
have already seen, Ubuntu is extremely flexible, and this area is no excep-
tion. Click the icon in the top right of the screen to see the various options
(shown in Figure 3-6) for ending your current computing session.

A number of options are available upon logout; however, the choices pre-
sented to you will depend on your installation (e.g., Suspend may not be
available).

� Lock Screen: This option locks the screen, which is useful when you
need to use the bathroom or grab some lunch. It locks the computer
and asks for your password to reenable the desktop.
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� Guest Session: This option lets you allow someone else to use your
computer while keeping you logged in but your data and account
secure by giving the guest a limited desktop to work with temporarily
and requiring your password to return to your desktop. 

� Switch from . . .: Your username will be listed here. This option takes
you to the login screen and lets you switch between logged in users
without logging anyone out. It also requires each specific user’s
password to access his or her account.

� Log Out: This option lets you log out of the current session and go
back to the main login screen.

� Suspend: If your computer supports it, this option will be included in
the list, and you can click it to save the current state of your system in
RAM. The next time your computer is turned on, the desktop will be
resumed. This option continues to use power, but only a minimal
amount.

� Hibernate: Save the current state of your system to the hard drive and
on a restart your computer will resume.

� Restart: Click this to restart the computer.

� Shut Down: Click this to shut down your computer.

Using Your Applications
Now that you have become familiar with the desktop, let’s explore some of
the many applications included on your new system. By default, Ubuntu
comes with a wide range of popular and established applications to listen
to music, watch videos, create documents, browse the Web, manage your
appointments, read your e-mail, create images, and much more. These
applications have been vetted by the developers to ensure they are the best-
of-breed Linux applications available.

Although Ubuntu includes a range of software applications, it is likely you
will want to install extra applications and explore other available software.
Fortunately, the Ubuntu system is built on a powerful foundation that
makes software installation as simple as pointing and clicking in the Ubuntu
Software Center, covered in Chapter 4. Just browse through the different cat-
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egories and check the applications to install. Click the Apply button, and the
application is downloaded and installed for you.

This tool provides a simple way to access a limited core set of popular appli-
cations, but there are actually more than 30,000 packages available to your
Ubuntu system. Software installation is discussed in detail in Chapter 4.

TIP Another Way to Run Applications
Although you will most typically start your applications by selecting them from the Applica-
tions menu, you can also press Alt+F2 (on Mac hardware, use Fn+Alt+F2) to bring up a box
where you can type in the name of an application and run it.

Browsing the Web with Firefox
Firefox is the default Ubuntu Web browser and provides you with a
simple, safe, and powerful browsing experience. Firefox is developed by
Mozilla and has become one of the most successful open source projects in
the world and continues to garner huge popularity. With hundreds of mil-
lions of downloads and rapidly increasing browser share, Firefox has been
an unparalleled success.

QUICK TIP You can learn more about Mozilla and Firefox, as well as their other software products, at
www.mozilla.org.

Fire up Firefox by clicking its icon (the first one next to the System menu)
on the panel or by selecting Applications > Internet > Firefox Web Browser.
Before long, you’ll be presented with the main Firefox window (Figure 3-7).

The Firefox window looks similar to most Web browsers and includes the
usual back, forward, reload, and stop buttons, an address bar, and some
menus. These familiar-looking elements help you become acquainted
with Firefox, and if you have used Internet Explorer, Opera, Chrome, or
Safari before, you are sure to pick it up in no time.

Navigating your way around the Internet is no different in Firefox than in
any other browser—just type the Web address into the address bar and
press Enter. Firefox also has a few nice features that make it easy to access
your favorite sites. As an example, if you want to visit the Ubuntu Web site,

Using Your Applications 73

www.mozilla.org


you can just enter www.ubuntu.com (leaving off all that http:// nonsense).
Alternatively, you can just type in “Ubuntu,” and Firefox will do the equiv-
alent of going off to Google, entering “Ubuntu” as the search term, and
taking you to the first result for the search. This feature is incredibly handy
for popular sites that are likely to be at the top of the search results page.

TIP The search box next to the address bar can be used to do searches. By default, these
searches are on Google. To do a Google search, just type in your search term and press
Enter. You can also click the down arrow next to the Google logo and select from a variety of
other sites to search, including sites like Amazon.com and Wikipedia.

This search box can be used to search just about anything. To add more search engines,
click the small icon and then select Manage Search Engines.

Bookmarking Your Favorite Sites  To bookmark the page you are view-
ing, click Bookmarks > Bookmark This Page or click Ctrl+D. In the drop
down box that pops up, use the combo box to select the folder to store the
bookmark in. You also have the option to add “tags” to your bookmark,
which are like keywords that can be used to sort and search for your book-
marks in the future. When you have finished naming and tagging your
bookmark, click Done to save the bookmark.
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Save Time with Live Bookmarks  Firefox also includes a special feature
called live bookmarks that automatically grabs content from a Web site with-
out your needing to visit it. As an example, go to http://fridge.ubuntu.com
(a popular Ubuntu news site), and you will see a small orange icon—which
indicates that this site has a feed available—on the right side of the address
bar. Click this orange square, and you will be taken to a new page that pre-
views the feed and gives you the option of what you would like to use to
subscribe to it. Use the default option (Live Bookmarks), and click Sub-
scribe Now. A dialog box will pop up. Use the default values provided and
click OK. A new toolbar button is added, and when you click on it, a list of
the items from the Web site are displayed. Each time you start Firefox, it will
quietly go away and update this list so that you don’t need to visit the site
yourself. The “Latest Headlines” toolbar entry is an example of this.

TIP If You Liked the Fridge
You may also like Planet Ubuntu at http://planet.ubuntu.com. This site collects the personal
blogs of a number of different Ubuntu developers and other community members. Planet
Ubuntu gives a unique insight into what the developers are working on and/or interested in.

Bolt It On, Make It Cool  Although Firefox is already a powerful and flex-
ible Web browser, it can be extended even further using special plug-in
extensions. These extensions cover not only typical browsing needs but
also other more specialized extras that extend the browser itself.

To install normal Web plug-ins, just visit a site that requires the plug-in. A
yellow bar will appear at the top of the page, indicating that you are miss-
ing a plug-in necessary to fully take advantage of the page you are visiting.
Click the Install Missing Plug-ins button to grab the required plug-in. For
example, Ubuntu does not come with the Adobe Flash plug-in because it
does not live up to Ubuntu software freedom requirements. As a result,
you will have the option to install either Adobe Flash or the free software
version Gnash if you want to use Flash.

To extend the browser itself with additional features, go to https://addons.
mozilla.org and browse for an extension that you are interested in. When
you find something you would like to install, click the Install link. A dialog
box will pop up asking you to confirm the installation. Click Install Now.
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Your new extension will now download and install automatically. Typi-
cally, this requires a restart of Firefox, and then your extension is available.

TIP Be Careful Where You Download
It is recommended that you download extensions only from http://addons.mozilla.org. If you
do need to install an extension from another site, make sure it is a site you trust. Otherwise,
the extension may contain unsafe software, viruses, or spyware.

Creating Documents with LibreOffice
Included with Ubuntu is a full office suite called LibreOffice. This com-
prehensive collection contains applications for creating word processing
documents, spreadsheets, and presentations installed by default with the
ability to easily manipulate and create databases, drawings, and mathe-
matical equations—all just a click away. The suite provides an extensive
range of functionality, including reading and writing Microsoft Office file
formats, and can also export documents as Web pages, PDF files, and even
animations.

TIP History of LibreOffice
Years ago, a company called Sun Microsystems acquired an office suite called StarOffice
when it bought the company that developed it, StarDivision. Sun Microsystems continued to
develop StarOffice as a proprietary office suite, but a few years later released an open source
version called OpenOffice.org. OpenOffice.org had slightly fewer features, but was still very
mature and gathered a large following. When Sun Microsystems was bought by Oracle,
some developers were unhappy with the direction the new company was leading develop-
ment and, since the code was open source, these developers created what is called a fork, a
project based on the same open source code up to that point, but which would then diverge
for all future development. This new office suite is called LibreOffice.

Let’s give LibreOffice a whirl by creating a letter with it. Start LibreOffice
word processor by clicking Applications in the Launcher and then find
LibreOffice. When it has loaded, you will be presented with the interface
shown in Figure 3-8.

If you have used a word processing program before, many of the common
interface elements, such as the buttons for setting font type and size, bold,
italic, underline, and alignment, look and behave the same. The LibreOffice
developers have designed the suite to be easy to migrate to if you have used
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a program like Microsoft Office before. After a few minutes playing with
LibreOffice, you will be confident that you can find the functions you need.

Start your letter by first choosing a nice font. In the font combo box, you
should see Liberation Serif (which is a free-as-in-liberty font similar to
Times) selected as the default. You can click the box and choose another if
you prefer, such as the lovely DejaVu Sans or the Ubuntu font. Change the
font size by clicking the combo box to the right of the font box and select-
ing 10 as the size. With the cursor on the left side of the page, add your
home address to the letter.

Now press Enter to leave a blank line under the address, and click the Align
Right toolbar button (the icon looks like some lines aligned to the right). If
you are unsure of what a button does, hover your mouse over it to pop up
a tool tip. Now add to your letter the address of the recipient.

Press Enter again to leave a blank line, and type the main body of the letter.
Feel free to use the bold, italic, and underline buttons to add emphasis to
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your words. You can also use other toolbar buttons to add items such as
bullet points and numbered lists and to change the color of the font. If you
want to add features such as graphics, tables, special characters, and frames,
click the Insert menu and select the relevant item. You can customize each
item added to the page by right-clicking the item and using the options
shown in the context menu.

When your letter is complete, you can save it by selecting File > Save, by
clicking the floppy disk toolbar icon, or by pressing Ctrl-S. The default file
format used by LibreOffice is the OpenDocument Format. This file format
is an official open standard and is used across the world. The file format is
slightly different for different types of applications (.odt for word proces-
sor files, .ods for spreadsheets, and so on), but each format provides an
open standard free from vendor lock-in. You can also save in a variety of
other formats, including the default formats for Microsoft Office.

TIP Vendor Lock-In?
In the proprietary software world, it is common for each application to have its own closed
file format that only the vendor knows how to implement. When a person uses the software
to create documents, the closed format means that only that specific tool can read and write
the format. As long as you want to access your documents, you need that tool. This is
known as vendor lock-in.

To combat this problem, the LibreOffice suite (and the vast majority of other open source
applications) uses an open file format that is publicly documented. In fact, the format is a
published standard under ISO/IEC 26300:3006. This means that other applications can
implement the OpenDocument file format, and you can be safe in the knowledge that your
documents will always be available and you are not locked in to any specific tool.

Another useful feature wedged into LibreOffice is the capability to save
your documents in the Adobe PDF format. PDF files have been increas-
ingly used in the last few years and are useful for sending people docu-
ments that they should not change (such as invoices). PDF files provide a
high-quality copy of the document and are well supported across all oper-
ating systems. This makes PDFs ideal for creating catalogs, leaflets, and fly-
ers. To save a document as a PDF file, click the PDF button on the main
toolbar (next to the printer icon). Click the button, enter a filename, and
you are done. Simple.
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Connecting with Empathy and Gwibber 
and the Indicator Applet
Empathy is a chat program that can interact with Google Talk, AIM, Win-
dows Live, and many other chat programs. It has audio and video capability
as well. You can get started by left-clicking the indicator applet (it looks like
an envelope) on the top panel and choosing Chat. You will then be given an
opportunity to enter your account information for various services and to
begin communicating.

Gwibber, listed in this menu as Broadcast, is accessible from the same loca-
tion and can be set up to allow you to integrate online services like Flickr,
Twitter, identi.ca, and Facebook into your desktop for even easier access to
what is happening in your social networks. Open it, enter your account
information as directed, and you can begin to interact with all your circles
from one location on your desktop.

On the top panel, you may have noticed your username with a speech bal-
loon icon next to it. This location gives you a convenient place to mark
yourself available for chat or away, update your information for social
accounts that use either Empathy or Gwibber, and use your Ubuntu One
services.

Ubuntu One
Ubuntu One is an online cloud storage application that is free for any
Ubuntu user. This enables any user to create an Ubuntu One account and
store up to 2GB on remote servers (more space is available for a fee) that
may be accessed from anywhere. The service is built in to the Ubuntu
desktop and, once activated, integrates smoothly. You can get started con-
figuring your account from the menu at System > Preferences > Ubuntu
One. More information is available at one.ubuntu.com and in Chapter 11.

Managing Your E-Mail and Calendars with Evolution
Evolution is modeled around the all-in-one personal information man-
agement tool. Within Evolution you can read your e-mail, manage your
schedule, store contact details, organize to-do lists, and more in a single
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place. This makes Evolution useful for both businesspeople and regular
users who want easy access to this information.

Setting Up Your E-Mail Account  To use Evolution to read your e-mail,
you need to find out the following settings for connecting to your e-mail
server (you can get these details from your ISP or system administrator):

� Your type of e-mail server (such as POP or IMAP)

� Your mail server name (such as mail.mailserver.com)

� Your mail account’s username and password

� Authentication type (typically by password)

� Your outgoing mail server type (typically SMTP)

� Your outgoing mail server name

To use Evolution for just the calendar function, you need to go to the indi-
cator applet (which looks like an envelope) in the notification area on the
top panel and click on Set Up Mail. In a few seconds, the Evolution Setup
Assistant window will pop up. Here are the necessary steps:

1. On the Welcome screen, click the Forward button.

2. Next, you may restore your e-mail from a backup, but since we are
doing a fresh setup, click the Forward button.

3. On the Identify screen, enter your full name and e-mail address in the
appropriate boxes. Under Optional Information, you should uncheck
the Make this my default account box. Then click the Forward button.

4. In the Receiving Email dialog box under Configuration > Server, just
add your name. You can add your name under Username as well.
Then click the Forward button.

5. On the Receiving Options screen, click the Forward button.

6. On the Sending Email and Server Configuration screen, add your
name here as you did in earlier steps.

7. In the Account Management dialog box, just click the Forward button.

8. On the Done screen, click the Forward button.
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9. Finally, once Evolution opens, click New Icon (looks like a clock), and
from the drop-down menu, select Calendar.

10. When the New Calendar window pops up, you can pick which type of
calendar you want to use. Note: If you don’t already have another type
of calendar, just leave the Type as CalDAV, then fill in the name—this
will be the name of your calendar. Pick the color you want your
events to show up as, then click Mark as default calendar.

If you are using Google calendar, you can also add this function to your
calendar. All the steps are the same, but when you get to step 10 to add a
new calendar, you need to choose Google as the type of calendar. Then fill
in the name you want to use for the calendar, choose the color, and mark
it as your default calendar. You probably want to copy the contents locally,
too, in case you need to access it when you do not have Internet access.
When you click Google, you will see a Username field show up under
Name. Your username should be your gmail name, but without the
“@gmail.com.” Once you enter your username, click on Retrieve List. You
will be prompted to enter your gmail password. Enter it. When the Enter
Password window goes away, you should see a list of calendars that you
have linked to your Google calendars. If you have more than one Google
calendar you want to add, then just pick which one will be your default
calendar. Repeat step 10 for each calendar you want to add.

TIP Evolution and Webmail
You can’t use Evolution to read Webmail such as Yahoo! Mail or Hotmail unless you config-
ure your Webmail to allow POP access and to use SMTP to send e-mail. Consult your Web-
mail provider for more details on if and how you can access the mail with a local client like
Evolution.

Click Applications to find and load Evolution. When the application loads,
you are taken through a wizard to set up your e-mail server (as shown in
Figure 3-9).

Click Forward to continue the setup, and after choosing to not restore from
a backup, you will be asked for your identity. Fill in your e-mail address in
the E-Mail Address box, and add the optional information if you want to.
The additional details are not essential for using Evolution. Click Forward
to continue.



You are next asked to choose what kind of e-mail server you have from the
drop-down box. When you make your selection, some additional settings
are displayed. Fill in the server name and the username. You may need to
adjust the Security and Authentication Type settings, but for most
accounts the default settings should be fine. Click Forward to continue.

The next page configures some options for receiving your e-mail. None of
these options are essential, although you may want to check the first box to
automatically check for new mail. Click Forward to continue. The next
screen configures the settings for sending e-mail. In the combo box select
the Server Type (typically SMTP) and add the server name to the Server
box. Click Forward to continue.

In the next screen, enter a name to describe the account. The default entry
(your e-mail address) is fine, but you may want to add something more
meaningful such as “Work E-Mail” or “Home E-Mail.” When you have
added this, click Forward to continue. Finally, select your location from the
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map. If you click on your area of the world, the map will zoom in. Once you
have done this, click Apply to complete the process and close the wizard.

With the wizard completed, the main Evolution interface will appear, as
shown in Figure 3-10.

On the left sidebar you can see a number of buttons to access the mail,
contacts, calendars, memos, and tasks components in Evolution. When
you click each button, the interface adjusts to show you the relevant infor-
mation about that component.

Working with Your E-Mail  Inside the e-mail component you can see the
e-mail folders in the left panel and the list of messages in the top pane.
When you click on a message, it is displayed in the bottom pane, where
you can read it. With your new account set up, you will first want to go and
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Figure 3-10 Those of you who have used Microsoft Outlook should find the
interface very similar.



grab the e-mail from your mail server. Click Send/Receive, and the mail is
retrieved from your server and any unsent mail is sent.

TIP Problems?
If you cannot connect to your mail server, there may be an error in your account configura-
tion. To edit your account settings again, click Edit > Preferences, select the account from
the list, and click Edit.

With your messages loaded, unread e-mails are shown in bold in the top
pane. Move through the different e-mails using the up and down arrow
keys, and each message will be displayed. You can reply to a message by
clicking the Reply or Reply To All toolbar buttons. New e-mails can be cre-
ated by clicking the New toolbar button. By default, new e-mails and
replies are sent automatically when you click the Send button in the com-
pose window. This way you don’t need to click the Send/Receive button to
deliver them.

Managing Your Calendar  Inside calendar mode, Evolution provides
another convenient way to manage your schedule, add new events, and
view your calendar in different ways. When you click the Calendars button
to switch to this mode, you can see the timetable for today as well as the
month view. The month view shows a couple of months in which the bold
dates have events.

You can add two types of events to your calendar.

� Meetings: These are events with a specific group of people.

� Appointments: These are general events. 

To add a new appointment, navigate to the date you require using the cal-
endar, then right-click a time slot in the day view, and select New Appoint-
ment. Alternatively, simply click the New toolbar item. In the box that
pops up, fill in the Summary, Location, Time (adjusting the date if neces-
sary), and Description boxes. You can also select on which calendar the
event appears if you have multiple calendars configured.
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TIP Multiple Calendars
Evolution supports multiple calendars. This is useful if you want different calendars for dif-
ferent types of events such as personal and work-related activities. To create a new calendar,
right-click the calendar list in the left sidebar and select New Calendar.

To add a new meeting, again find the date, right-click the day view, and
select New Meeting. Inside the dialog box that pops up, you need to add
the participants who are attending the meeting. You can add participants
in two ways: Use the Add button if they are not in your address book, or
use the Attendees button if they are in your address book.

When you click Attendees, a new dialog pops up with a list of attendees
down the left. You can use the Add and Remove buttons to add contacts to
(or remove them from) the different categories of Chairpersons, Required
Participants, Optional Participants, and Resources. Now, you probably
don’t have any contacts in there, as you are just starting to use Evolution,
so use the main Contacts button on the left side of the main Evolution
window to add some.

You can view your calendar in lots of different ways by clicking the differ-
ent toolbar buttons such as Week, Month, and List. Play with them and see
which ones are most useful to you.

QUICK TIP Remember, you can access your appointments without opening Evolution by clicking on the
clock in the panel.

The Ubuntu File Chooser and Bookmarks
One area in which the GNOME developers have worked hard is in creating
an intuitive and useful file chooser that is accessed in applications with
File > Open. The window that pops open is called the file chooser. You may
be wondering why they have spent so much time on such a small and seem-
ingly insignificant part of the desktop. In reality, however, finding files is
one of the most frustrating aspects of using computers and often involves
digging through folder after folder to find what you need. Luckily, the
GNOME file chooser (Figure 3-11) helps cut down much of this file hunt-
ing significantly.
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The listing of files on the right-hand side is used to find the file you need,
and you can click on folders in this listing to traverse deeper into your sub-
folders. Note how each folder is displayed above the listing in a series of
buttons. You can click these buttons to easily jump back to parent folders
when needed.

Aside from enabling you to manually pick files, the chooser also supports
bookmarks. On the left side of the chooser is a list of devices and bookmarks
labeled Places. These include your home directory (shown as your user-
name), Desktop (the files on your desktop), and File System (the entire hard
drive), as well as devices such as CD drives, floppy drives, and USB sticks.

To create your own bookmark, use the listing on the right to find the folder
that you want to bookmark, single-click it, and then click Add below the
Places box. You could also right-click on the file and choose Add to Book-
marks. The folder now appears in your bookmarks. Now whenever you
need to access that folder, just click the bookmark! In addition to putting
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the bookmark in the file chooser, it is also available in other parts of the
desktop, such as the Places menu and in the file manager.

Ubuntu in Your Language
When you installed Ubuntu, you were asked which language the system
should use. Although this sets the initial language for the system, you may
want to change the language at a later date. To do this, click Applications
from the Launcher and find Language Support.

Ubuntu supports a huge range of different languages, and many applica-
tions include a Translate This Application menu option in the Help menu
so that all Ubuntu users can contribute translations in their language(s). If
you would like to help with this effort, it is a fantastic contribution to the
Ubuntu project.

When the language selector first loads, it may ask you to update your lan-
guage packs. Just click Yes to continue. Inside the dialog box a number of
languages are listed, each of which has a Support checkbox listed next to it.
For each language that you want available on the system, check the rele-
vant boxes.

When you have selected the boxes, click the Apply button, and the appro-
priate language packs are downloaded and installed. Now use the Default
Language combo box to choose the new language. You need to log out and
log back in for the changes to take effect.

TIP Choosing a New Language
When you see the login screen, you can use the Language button to choose a language for
that specific login session. When you select the language, you are asked if you want to make
it the default language or use it just for that specific session.

Customizing Ubuntu’s Look and Feel
Whenever we put someone in front of Ubuntu for the first time, there seems
to be a uniform natural desire to tweak the look and feel of the desktop. It
can be fun tweaking our desktops so they look just right, and Ubuntu has
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great support for all kinds of adjustments. Do you want different-looking
applications with a lime green background and crazy fonts? No problem;
just don’t show it to anyone else. . . .

Changing the Background
To change the background of your desktop, right-click it and select Change
Desktop Background. Inside the dialog box that appears, choose your wall-
paper by clicking on an image, and the desktop background will automati-
cally change. Ubuntu comes with a limited range of preinstalled wallpapers,
so it is likely that you will want to add your own wallpaper. To do this, save
your wallpaper somewhere on your computer, and then use the Add Wallpa-
per button to select it. The new wallpaper can be selected from the list.

If you are not really a wallpaper kind of person and would prefer just a
color for the background, you can use the Desktop Colors controls at the
bottom of the dialog box. The combo box provides three different types of
background: Solid Color, Horizontal Gradient, and Vertical Gradient. Next
to the combo box, click on the color chip to select the relevant color(s).

Changing the Theme
When you are using your applications, the visual appearance of the but-
tons, scroll bars, widgets, and other bits and pieces are controlled by the
theme. The built-in theming system can make your applications look radi-
cally different, and Ubuntu ships with a number of themes that you can try.

Choosing a New Theme  To choose a new theme, click Applications from
the Launcher and find Appearance and then click on the Theme tab. Inside
the tab that pops up are a number of themes that you can choose. Just click
on a theme, and the desktop will be adjusted automatically. You can fur-
ther customize your theme by clicking the Customize button. A new dialog
box appears that has tabs for the different parts of the theme you can con-
figure. Click each tab, and select an entry from the list to create your own
perfect theme.

Installing New Themes  To install a new theme, head over to http://art.
gnome.org and find a theme that you like. You can do this directly from
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the Theme tab in the Appearance window by clicking Get more themes
online. You need to look for Controls and Borders when browsing under
the Themes tab on the site. When you find a theme that you like, download
it to your computer. Now Click System > Preferences > Appearance, and
click the Install button in the Theme tab. Using the file chooser, find the
theme that you just downloaded, and it will install automatically. You may
now select your new theme from the list.

Configuring a Screensaver
To choose a different screensaver, click Applications from the Launcher
and find Screensaver. This will load the screensaver configuration tool
(Figure 3-12).

On the left side of the window is a list of available screensavers. Click on a
screensaver and you will see a preview appear in the space to the right of
the list. You can then use the slider to select how long the computer needs
to be idle before the screensaver kicks in.

Customizing Ubuntu’s Look and Feel 89
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The Lock Screen When Screensaver Is Active checkbox can be selected to
lock the screen when the screensaver starts and, as such, requires a user to
enter the password to reactivate the desktop. This is useful if you work in an
office and want to ensure that no one tampers with your computer when
you are away.

Managing Your Files
Files are the primary components of any computer use, and they need to be
managed, copied, moved, renamed, grouped, and loaded. Included with
Ubuntu is a powerful yet simple file manager called Nautilus that integrates
tightly into your desktop. You’ll use it all the time even if you don’t often see
that name. Most often, you will see it referred to as File Browser.

File Browser makes extensive use of drag and drop. Unlike the kind of file
manager used in Windows with its tree view and listing of files, File Browser
displays files in a series of windows in which you can drag files around easily.
For those who just can’t say goodbye to the tree view, File Browser also sup-
ports that. Aside from providing a simpler user interface, File Browser also
includes a number of useful features such as video and image previews,
emblems, bookmarks, permissions management, and more.

You can start File Browser from the Launcher. When the folder loads, you
should see something similar to what Figure 3-13 shows.

The File Browser window is split into two parts. The sidebar shows cate-
gories of information such as bookmarks, folders, emblems (more on these
later), and more. In the main part of the window, you can see the subfolders
and files in the current folder. By default, File Browser displays your book-
marks in the left sidebar and displays the contents of your home folder.

So, let’s play with File Browser and see what you can do with it. The first
important skills to learn involve general file management. Many of the
tasks you need to do can be achieved by right-clicking your file/folder and
selecting the relevant option. There are also a number of options in the
Edit menu.

First, create a folder by right-clicking the main part of the window and
selecting Create Folder. A folder is added, and you can type in the name of
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it. If you change your mind about the name, rename it by right-clicking
and selecting Rename. If you double-click on a folder, you can access it and
perform the same operations within that folder.

QUICK TIP Just as folders and directories are the same thing, so are folders and subfolders . . . well,
almost. When we refer to subfolders, we are referring to folders contained within another
folder. For example, /home is a folder, while we can refer to /home/mako as a subfolder of
/home.

File Browser is also flexible in how your files are displayed. You can view
the files and folders as either the default collection of icons or as a list. To
switch to the list view, select View > View As List. You can also configure
the organization of how your files and folders are displayed by right-click-
ing the main part of the window and selecting one of the options in the
Arrange Items menu. Play with each of these options to see which ones
work best for you.
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Figure 3-13 Accessing your home folder files is as simple as clicking Places >
Home Folder.



QUICK TIP Just like in the file dialog, File Browser displays each of the different parts of the path as dif-
ferent buttons. As an example, /home/mako/work would have three buttons: home, mako,
and work.

Selecting, Copying, and Moving Files and Folders
Copying and moving files and folders are simple tasks with File Browser
and can be done in a number of different ways. To test this, create two
folders called Work and Invoices in your home directory. Save some files
inside each folder. You can quickly create empty files by double-clicking
the folder to go into it, right-clicking, selecting Create Document > Empty
File, and renaming the file to something useful. With a couple of folders
now complete with files in them, let’s move them around.

One method is to use two windows. Right-click the Work folder, and select
Open in new window. You now have two windows open, one with the con-
tents of Work and one with the contents of your home directory. Now
copy the Invoices folder to the Work folder by clicking it and dragging it
over to the second window (which shows the contents of Work). By
default, dragging from one window to another copies the item.

Another option is to select what you want to copy and paste it. Selecting
items can again be done in a number of ways. One method is to click each
file/folder while holding down the Shift or Ctrl keys to make multiple selec-
tions. The difference between the two keys is that Shift allows you to select a
number of files and folders next to each other, and Ctrl selects independent
files and folders from anywhere in the folder-listing view. When you have
selected what should be copied, right-click and select Cut or Copy. Cut will
copy the original files but remove them, and Copy will just copy them while
leaving the original files intact. Now go to the destination folder, right-click
it, and select Paste. The files/folders are now added.

Using the Sidebar
The sidebar in File Browser can be changed to a variety of views that
should cater to virtually all tastes. Each of these different sidebar views has
a range of functions. Table 3-1 explains each one.
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Although you will probably stick with one in particular, it is not uncom-
mon to switch between options to achieve a particular task. For this rea-
son, the flexibility provided by the range of sidebar options is useful. You
can find out more about using File Browser at http://live.gnome.org/
DocumentationProject/UserGuide/Nautilus, where it is referred to using
its official GNOME name, Nautilus.

TIP Drag and Drop
If you want to put something in the Places view, drag and drop the item. The Ubuntu desktop
is filled with drag-and-drop shortcuts like this. If you think something could be dragged and
dropped, try it!

Graphically Accessing Remote Files
Within the Ubuntu desktop, you can use the same powerful file manager
to manage files that are on a remote server, either on your local network or
in far-flung parts of the world via the Internet. This feature is incredibly
useful when you need to transfer lots of files around, such as when you
work on Web pages or need to make your work remotely available to
someone else. To access these files, you can connect to the server in various
ways, each of which requires a connection profile. This profile configures
the connection, and you need to gather your server’s settings to create it.
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Table 3-1 The Different File Browser Sidebar Options

Option Feature

Places (Default view) Includes the devices and bookmarks in the sidebar
that you typically see in the File Browser.

Information Displays some limited information about the current folder.

Tree Displays a tree view similar to Windows/Mac OS X. Those of you
who love the way Windows/Mac OS X works may want to use this.

History Displays a history of the folders you have clicked on.

Notes Allows you to write notes in the sidebar that are stored in the
folder. This is handy when you need to explain or make comments
about the current folder.

Emblems Lists the files and folders that have specific emblems attached.
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To set up the connection, click File Manager from the Launcher, hover
over the File Manager name at the top of the screen and choose Connect to
Server from the File menu. You will see the dialog shown in Figure 3-14.

When the dialog box appears, select the type of connection from the
combo box. The box then adjusts to display the settings required, and you
should make sure the Name to Use for Connection box contains a descrip-
tive name for the connection, such as “Work Server” or “Web Site.” When
you have added the settings, click the Connect button to continue.

An icon now appears on your desktop for the connection. Double-click the
icon, and you are asked for a password to the server. Enter this password,
and you are then asked if you would like to store your passwords in the
keyring. The desktop keyring provides a convenient place to store all of
your connection passwords, and you need to remember only the password
for the keyring itself. If you choose to store the password in the keyring, you
are asked for a password for it. In the future, whenever you double-click the
icon to access the server, you will be asked for the keyring password.

When you have been authenticated to access the server, your files appear in
a file manager window, and you can use the file manager as normal.

You can also use File Browser to access Samba and NFS shared drives, FTP
servers, remote ssh connections, and more by using the correct prefix in an
entry in the Location box, such as ssh://accountname@192.168.1.109 to
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access an account on a computer at that IP address on your network via
ssh. Use smb:// for Samba, nfs:// and ftp:// for those protocols.

QUICK TIP You can learn more about the protocols File Browser can use to connect to shared storage
and how to use them at http://library.gnome.org/users/user-guide/stable/gosnautilus-
515.html.en.

Ubuntu and Multimedia
In recent years, multimedia has become an essential part of computing.
Watching DVDs and videos and listening to CDs and music have become
part and parcel of the modern desktop computer experience. These multi-
media capabilities have been further bolstered by the huge popularity of
legal music downloading. With a range of online stores for a variety of dif-
ferent types of music, it is not uncommon to listen to most of your music
without ever seeing a little shiny silver disk.

Installing Codecs
Multimedia files and disks come in a variety of different types, and each
type uses a special codec to compress the content to a smaller size while
retaining a particular level of quality. To play this media, you need to
ensure that you have the relevant codecs installed. Ubuntu now makes this
easier by suggesting packages that provide a suitable codec when you open
a file that isn’t supported by the ones that are currently installed. Simply
double-click the file you want to open, and you should be provided with a
list of packages that you can install to enable support for the file you have
tried to open. Select the packages that seem appropriate, and click Install.

QUICK TIP If you double-click a file but no packages are suggested, you may need to change the pack-
age filter in the top right-hand corner to All Available Applications.

Codecs still remain a problem for open source software because of the
legal restrictions placed upon them. Certain codecs (including MP3, Win-
dows Media Format, QuickTime, and RealMedia) are proprietary and as
such have restrictions placed on their use, distribution, and licensing.
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Although developers in the open source community have gone away and
created free implementations of some of these codecs, the licensing that
surrounds them conflicts with the legal and philosophical position that
Ubuntu has set. These codecs are excluded not only because they are
legally dubious but also because they disagree with Ubuntu’s ethic of cre-
ating a distribution that consists entirely of free software in the most free
sense of the word.

QUICK TIP If you want to find out more about installing these codecs, see https://help.ubuntu.com/
community/RestrictedFormats.

To work toward resolving these problems, a number of developers are work-
ing on free codecs such as Ogg Vorbis and Ogg Theora that provide high-
quality results and open licensing. The Ogg Vorbis codec is used on audio
and can provide better results than MP3 at a smaller file size. The Ogg
 Theora codec is used for video and competes with the MPEG-4 codec.
Ubuntu includes the Ogg Vorbis and Ogg Theora codecs by default, and you
can encode and play back any media that uses those codecs out of the box.

Although the world would be a better place if all codecs were free, the real-
ity is different, and many Ubuntu users still want to play media compressed
with proprietary codecs. Table 3-2 shows the most typical codecs used to
encode and play back media and lists their support in Ubuntu.

Listening to Audio Files
Ubuntu includes a powerful music player called Banshee Media Player to
organize and play your music file collection. By default, Ubuntu will look
for music in the Music directory accessible in the Places menu.

Using Banshee  Load Banshee (Figure 3-15) by clicking on Applications
from the Launcher and find Banshee Media Player. The Banshee window
is split into a number of different panes, each displaying different details
about your music collection. The left pane (Source) lets you select the
source of the music, such as your media library, podcasts, and Internet
radio. Each of these options has a browser pane available to display the
source of the content. As an example, when you use the Library, one pane
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Table 3-2 Codec Support

Codec File Type Included Supported

MP3 .mp3 No Yes

Ogg .ogg Yes N/A

Flac .flac Yes N/A

Windows Media Audio .wma No Yes*

Wave .wav Yes N/A

MPEG-1 .mpg No Yes

MPEG-2 .mpg No Yes

Raw DV .dv Yes N/A

Quicktime .mov No Yes*

Windows Media Video .wmv No Yes*

AAC Audio .m4a No Yes*

* These codecs involve the installation of nonfree software that may or may not be legal in your country.

Figure 3-15 Banshee is a great place to look after your music collection.



displays the artists and one displays the albums. You can use this to navi-
gate your music. Be sure to explore. You can even fix metadata for files in
your collection from Tools > Fix Music Metadata.

Listening to Podcasts  Podcasts are audio shows that you can subscribe
to, and they are increasingly becoming the new way to listen to audio and
music. When you subscribe to a podcast, each new release is automatically
downloaded for you. This makes it extremely convenient to regularly lis-
ten to audio shows.

Banshee has good support for Podcast feeds, and subscribing to a feed is
simple. In the sidebar, right-click the Podcasts entry and click New Podcast
Feed. Paste in the feed by right-clicking the box and selecting Paste. The
files are automatically downloaded, and you can listen to them by double-
clicking on them. Each time you start Banshee, a check is made to see if
any new episodes exist, and if so, they are downloaded.

NOTE Banshee and iPods
Banshee can also read songs from your iPod—just plug it in and it will display in Banshee.
Banshee can read from the iPod but may not be able to write to all iPods.

Playing and Ripping CDs
Banshee Media Player can both play CDs and also rip their contents to
your hard drive. Insert your CD into the drive and open Banshee. To play,
select the CD from the list on the left and click the play icon (the arrow).
To rip, which Banshee calls importing, hover over the Banshee Media
Player text in the top panel and select Import Media from the Media
menu. Edit > Preferences will let you adjust settings while other options
can be found in various menus.

Buying Music
Canonical has added options within Banshee. You may now buy music
through the Ubuntu One Music Store alongside Jamendo, Magnatune,
and the Amazon MP3 Store. While Jamendo and Magnatune are great
sources for creative commons and other open-licensed music, for the first

98 Chapter 3 � Using Ubuntu on the Desktop



time, major and minor label artists will have their music available directly
from within Ubuntu. These are the songs you would typically find in your
local record shop or on a radio station. Music in the Ubuntu One Music
Store will be encoded at a minimum of 256 kbps in MP3 format without
any digital rights management (DRM). An Ubuntu One account (men-
tioned earlier in the chapter) is required to purchase music.

NOTE You can learn more about the Ubuntu One Music Store at https://wiki.ubuntu.com/UbuntuOne/
MusicStore.

Interacting with Photos
Shotwell is a photo management program that you may use to import
your pictures, organize them, and perform basic touch-ups like removing
red eye, cropping, or simple color adjustment. When Shotwell imports
photos, it reads the metadata embedded in the image file and then sorts
the images by date. Once done, it creates a timeline that allows you to view
photos easily as a group, individually, and even as a full-screen slideshow.
You can export your photos individually or in groups directly from
Shotwell to well-known Web services like Flickr or Google’s Picasa, to a
folder, or even to a CD you could give to a friend or family member.

Watching Videos
To watch videos in Ubuntu, you need to ensure that you have the correct
codecs installed. As discussed earlier, some of these codecs are available
separately due to the legal implications of including them with the
Ubuntu system. Although the new process for suggesting and installing
codecs should cover most popular types of files, you should still refer to
the Ubuntu wiki at http://wiki.ubuntu.com for details of how to install
ones that are not recognized.

Using Movie Player  To watch videos in Ubuntu, you use the Movie Player
(Figure 3-16). Load it by clicking Applications from the Launcher and find
Movie Player.

To watch a video on your hard disk, click Movie > Open, and select the file
from the disk.
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TIP Another Way to Load Files into Movie Player
You can also load multimedia files into Movie Player by double-clicking them on your desk-
top or in the file manager.

Movie Player also supports video streams. To watch a stream, click Movie >
Open Location, and enter the Internet address for the stream. The video
feed is then loaded and displayed.

Getting DVDs to Work  Ubuntu comes with DVD support for unen-
crypted DVDs. With the DVD industry being what it is, the majority of
DVDs come encrypted, and if you want to watch them, you need to ensure
that a library that can decrypt these DVDs is installed. Unfortunately, this
library needs to be installed separately and is not included with Ubuntu.
Refer to the Ubuntu restricted formats page at https://help.ubuntu.com/
community/RestrictedFormats for details.

With the library installed, insert a disk into your computer, and Ubuntu
will automatically start Movie Player to view the disk. Alternatively, fire up
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Movie Player, and click Movie > Play Disk to play the DVD. Movie Player
doesn’t support DVD menus but you can still use it to play a DVD.

If you are settling down to watch a movie, you may want to configure a few
other settings. First click View > Aspect Ratio to select the correct aspect
ratio for your screen, and then select View > Fullscreen to switch to full-
screen mode. To exit full-screen mode, just move your mouse, and some
on-screen controls will appear.

TIP Control Movie Player with a Remote Control
Movie Player supports the Linux Infrared Control (LIRC) library so you can use a remote
control while watching your media.

If you want to use a remote control with your Ubuntu computer, you need
to install the Linux Infrared Control (LIRC) package. LIRC is the library,
and it supports a wide range of remote control units.

The first step is to determine which LIRC driver is required for your par-
ticular remote control. Take a look at the list of remotes on the LIRC site at
www.lirc.org, or use your favorite search engine if your remote is not listed
on the site.

LIRC includes a number of built-in drivers. You can see which ones are
included by running the following command:

foo@bar:~$ lircd –driver=help

When you know which driver is required and you know your installed
LIRC supports your hardware, you can edit the hardware.conf file in the
/etc/lirc file to configure which one is used. Simply set the DRIVER line to
the driver you selected. Then restart LIRC:

foo@bar:~$ sudo /etc/init.d/lirc restart

When you press the buttons on your remote control, a code should appear.
This code can be mapped to a button on your remote by editing the
lircd.conf file in /etc/lirc. For more information, see http://help.ubuntu.
com/community/LIRC.
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Creating Videos
PiTiVi is a movie editor that is based on the same media framework as Ban-
shee and Movie Player, GStreamer. As a result, it handles any video format
supported by GStreamer, which makes it very powerful indeed. It has inter-
face options ranging from the simplicity of Apple’s iMovie to a more com-
plex professional view, as in Complex View. The goal is an easy-to-use but
powerful piece of software for taking your video footage from your camera
and editing it, adding effects and transitions, and mixing audio to create
your own personal cinematic masterpiece. More information about PiTiVi
is available at www.pitivi.org. Click Applications from the Launcher and
find Pitivi Video Editor to try it out. 

Exploring the Ubuntu Landscape
Unlike many other operating systems, Ubuntu includes a comprehensive
suite of applications right inside the system. This range of tools has been
selected to allow you to install Ubuntu and get your work done, communi-
cate with other people, read and create documents, watch and/or listen to
media, and more. Unfortunately, due to space restrictions, this book can
only skim over the surface of available applications.

To help remedy this a bit, here is a quick summary of many of the applica-
tions listed in the Applications menu in Ubuntu. For all, click Applications
from the Launcher and find the name.

� gedit Text Editor

This simple yet powerful text editor is ideal for editing documents,
making quick notes, and programming. Included is a range of plug-
ins for spell checking, statistics, file listings, and more.

� Calculator

For those times when you need to figure out a percentage or calculate
whether you are getting a raw deal from your employer, the calculator
is there. It provides a range of functionality for simple and scientific
calculations.

� Terminal

Underpinning the desktop is an incredibly powerful command-line
core. This application puts a window around a command-line
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interface and allows you to configure transparency, fonts, behavior,
and more. Essential for the command-line junkies among you.

� Mahjongg

For those of you who actually understand the rules of Mahjongg, this
application provides a great implementation of the game.

� Sound Recorder

If you need to record something, such as your voice for a podcast or
audio message, you can use this simple tool.

� System Monitor

To get an idea of the current performance or load on your computer,
click on this tool. The System Monitor lets you know which
applications are running and how much memory/processing power
they are using, and it also allows you to kill or restart processes that
are hogging the resources.

� Sudoku

Play the increasingly popular logic game on Ubuntu.

� Disk Utility

Bits and bytes never looked so good! In case you were wondering
exactly where all your disk space had gone, this will help solve the
mystery.

Other Applications to Try  There are literally thousands of available pack-
ages that can be installed on your Ubuntu computer. These packages span
a range of different areas, and this section highlights some of the popular
ones. Software installation is covered in Chapter 4.

� Inkscape

Package to install: inkscape

Inkscape (Figure 3-17) is a drawing package for creating Scalable
Vector Graphics (SVG). Ever since the SVG format was introduced, it
has taken the design world by storm. SVG allows the creation of
graphics that can scale to any size. Inkscape is a hugely flexible tool
for creating such graphics, and a huge range of icons and artwork in
open source projects are made in Inkscape.
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� Gimp

Package to install: gimp

The GIMP Image Editor (Figure 3-18) is a powerful raster or bitmap
graphics program that lets you draw, paint, edit images, and much
more. It is similar to proprietary graphics programs and has the ability
to process and create images using layers, plug-ins, and much more.
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� Blender

Package to install: blender

Blender (Figure 3-19) is an incredibly powerful 3D modeling,
animation, rendering, and production studio. Blender amasses an
impressive range of functionality for creating photorealistic scenes,
animations, and real-time virtual walkthroughs. Blender is also fully
scriptable in Python.

� Scribus

Package to install: scribus

Scribus (Figure 3-20) lets you lay out pages graphically and create
publication-ready output in PDF and Postscript formats. It is ideal
for newsletters, magazines, technical documentation, and more. It
supports CMYK color, Unicode text, and many graphic formats in the
creation process.
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� Bluefish Editor

Package to install: bluefish

For those of you who want to create Web pages but prefer to write
code, Bluefish Editor (Figure 3-21) is a lightweight but feature-rich
editor with support for a range of languages as well as HTML and
CSS.

� Audio CD Extractor

Package to install: sound-juicer

Many of us have legally purchased compact disks that we would like
to listen to using our computer or portable music player. Audio CD
Extractor (Figure 3-22) will help you record the songs to your hard
drive so you may do so.
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Moving to the Next Ubuntu Release
So your system is up to date and current, but Ubuntu doesn’t like to let the
grass grow. One of the original goals for Ubuntu was to have frequent
releases, and with only one notable exception (the 6.06 LTS release, which
was delayed by two months), there have been six months between each
release since 4.10. This book has been revised for the latest version—11.04—
but another release will be along soon. Release 10.04, like the earlier 8.04 and
6.06, was a Long Term Support (LTS) version of Ubuntu, supported for three
years on the desktop and five on the server. All other versions, such as 11.04,
are supported for eighteen months and at the same time are superseded by a
new version every six months. Essentially, if you are running the LTS version,
you might not be too interested in moving to the latest and greatest until the
next LTS version comes out, but if you are running a regular release version,
you might be the sort of person who is more interested in the latest and great-
est software updates. In either case, this is how you perform the upgrade.

Doing the Actual Upgrade
A graphical tool called Update Manager, found in the Applications menu,
tells you when a new version of Ubuntu is available and walks you through
the upgrade process. Note that if you already know or want to learn the
manual method, that is fine too. Both means will achieve the same result.

When a new release is available, Update Manager will alert you, as in Fig-
ure 3-23. All you need to do is click on the Upgrade button to start the
process. You will first be shown the release notes, which mention new fea-
tures or any outstanding bugs. After you click on the Upgrade button on this
screen, the necessary changes to your software repositories are made, and
then the program downloads and installs the new distribution. You may be
prompted if you have changed any configuration files. After the actual
installation is complete, you will be told which, if any, packages are no longer
officially supported by Ubuntu (have moved to the universe repository).
Last, all you need to do is restart your computer when prompted, and you
will begin enjoying the new release.

You can also initiate an upgrade simply by inserting a CD that contains a
newer version of Ubuntu than the one you are currently running, as shown
in Figure 3-24. Follow the prompts for an upgrade experience similar to
using the update manager.
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Figure 3-23 Upgrading from Ubuntu 10.10 using Update Manager and an Internet
connection

Figure 3-24 Upgrading from Ubuntu 10.10 using a 11.04 CD



Summary
In this chapter, you’ve learned how to start using the core features of your
new desktop. These concepts should allow you to perform most of the day-
to-day tasks when using your computer and provide a base from which to
explore the other applications installed on your system. This solid ground-
ing in the desktop paves the way for you to meander through the rest of the
book, learning about the more advanced uses of your new system and
exploring the enormous flexibility that Ubuntu provides.

Always remember that there is a wealth of help and documentation available
online. If you ever find yourself stuck, take a look at the Ubuntu Web site at
www.ubuntu.com or the Ubuntu documentation at http://help.ubuntu.
com and make use of the forums, wiki, mailing lists, and IRC channels.
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. (dot), folder name prefix, 133

* (asterisk), wildcard character, 338

@ (at sign), in command-line username, 327

# (hash), comment indicator, 156, 158

- (hyphen), dash in commands, 329

? (question mark), wildcard character, 338

| (vertical bar), pipe symbol, 134–135, 329

[ ] (brackets), wildcard characters, 338

[! ] (brackets, exclamation point), wildcard

characters, 338

$ (dollar sign), UNIX shell symbol, 327

~ (tilde), home directory indicator, 327

3D mapping, 286

3D modeling, 105

Access rights. See Permissions.

Accessibility, 20

Account tab, 320

Add or Remove Software section, 267

addgroup command, 336

Adding

partitions. See Partitioning disks.

text with Scribus, 192

user accounts, 67–68, 122–123, 336

user groups, 336

Adding/removing programs and packages. See

also Add or Remove Software; Installing;

Software Center.

APT (Advanced Package Tool), 114

dependencies, identifying, 114

finding packages, 116–117

installing packages, 116

libraries, definition, 115

listing available software, 112–113

online repositories, 114

package management, 115–117

packages, definition, 114

removing packages, 116

reviewing installed software, 112–113

software channels, 114

Software Management, 260–263

Synaptic, 115–117

Ubuntu Software Center, 112–114

Address book

managing. See Evolution.

synchronizing with Ubuntu One, 322

adduser command, 123, 166

Adept. See KPackageKit.

Administrator account, Ubuntu Server, 

153–154

Adobe Photoshop, Ubuntu equivalent. See

GIMP.

Advanced Package Tool (APT). See APT

(Advanced Package Tool).

Advanced tab, 264, 267

Advanced User Settings section, 269–271

Advocacy for Ubuntu, 240

Akregator, 282–283

Albisetti, Martin, 237

Algebra application, 206
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Alternate install CD, Ubuntu. See Installing

Ubuntu from alternate install CD.

amachu, 237

Amarok music manager, 273–274

AMD64 support, 35

Anagrams, 201

Andalusian government displaying, 306

Animation, 105

Annotating folders. See Emblems.

Answers, 29, 312–313

Applets. See specific applets.

Application Launcher, 254–255

Application launchers. See also Launchpad;

Unity Launcher.

changing, 120–122

F2 key, 73

Kubuntu, 254–255

Ubuntu desktop, 63–64

Applications. See also specific applications.

closing, 63

docking. See Docky.

educational. See Educational applications.

installing, 72–73

Kubuntu. See Kubuntu applications.

minimizing/maximizing, 63

moving between virtual desktops, 70

open, displaying, 70

restoring, 64

switching between, 70

Unity desktop, 63–64

Appointments. See also Calendars.

Evolution, 84–85

Kubuntu, 281–282

APT (Advanced Package Tool)

adding/removing programs and packages,

114

comment lines, 156

package management, 155–157

apt-cache utility, 158–159

apt-get utility, 158–159

aptitude utility, 163–164

Architectures supported by Ubuntu, 34–35

ARM support, 35

Array failure, 148

Array management. See LVM (Logical Volume

Manager).

Artwork, creating for Ubuntu, 241

Aspect ratio, videos, 101

Asterisk (*), wildcard character, 338

Astronomy application, 203–204

At sign (@), in command-line username, 327

Audio. See also Music.

listening to, 96–98

playing CDs, 98

podcasts, 98

recording, 103

settings, 69

Audio CD Extractor, 106–107

Automatic

name completion, files and folders, 329

software builds, 309

Backgrounds, desktop. See Themes and

backgrounds.

Backing up data. See also RAID (redundant

array of inexpensive disks).

incremental backups, 135–136

prior to installation, 40

RAID (Redundant Array of Inexpensive

Disks), 147

strategies for, 135–136

tools for, 136

Backports repository, 155

Bacon, Jono, 196, 229

Balneaves, Scott, 236, 301

Banshee, 96–98
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bapoumba, 235

Bazaar, 28–29, 314

Bienia, Michael, 236

/bin folder, 135

BIOS configuration problems, 39

Blender, 105

Blinken, 206

Blogs, 75, 226

Bluefish Editor, 106–107

Blueprint, 28

Blueprint Tracker, 311–312

Bochs, 173

bodhi.zazen, 235

Bookmarks

Firefox, 74–75

GNOME file chooser, 86–87

live, 75

synchronizing with Ubuntu One, 323

tagging, 74

Web sites, 74–75

Books and publications

Inkscape: Guide to Vector Drawing 

Program, 191

The Linux Documentation Project, 341

The Official Ubuntu Server Book, 171, 341

A Practical Guide to Linux® Commands..., 341

/boot folder, 135

“Bootable flag” setting, 56

Bootable partitions, specifying, 56

Brackets, exclamation point ([!]), wildcard

characters, 338

Brackets ([ ]), wildcard characters, 338

Brasero Disc Burner, 125

Broadcast, 79

Broadcast preferences, configuring, 66

Browsing

files in Kubuntu, 272

the Web. See specific Web browsers.

Bug #1, 24–25

Bugs

debugging. See Technical support;

Troubleshooting.

fixing, 23–24

reporting and tracking, 28, 242.  See also

Launchpad; Malone.

Build queue approach, 162–163

Bulletin boards. See The Fridge; IRC (Internet

Relay Chat); Mailing lists; Web forums;

Wikis.

Burn from Disk Image option, 37

Burning CDs. See CDs, burning.

Buttons, Unity desktop, 63–64

byobu, 338–340

Calc, 274

Calculator, 274, 284

Calculator application, 102

Calendars. See also Evolution; KOrganizer.

accessing from the clock, 69–70

Kubuntu, 281–282

Calendars, Evolution

appointments, 84–85

enabling, 80–81

events, 84–85

Google calendar, 81

meetings, 84–85

multiple calendars, 85

Cameras. See Digital cameras.

Canonical, definition, 12

Canonical Ltd.

Bazaar, 28–29

founding of, 11–12, 25–26

geographical location, 26

Launchpad, 28–29

new CEO, 26

service and support, 26–28
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Canonical Ltd., continued

version control tool, 28–29

as a virtual company, 11–12

working with other companies, 27

Carter, Jonathan, 236–237, 301

Castro, Jorge, 229

cat command, 329, 335. See also zcat

command.

Categorizing folders. See Emblems.

cd command, 329, 332

CD images. See .iso files.

CD/DVD burners

GNOME, 38

ISO Recorder, 38

Nero Burning ROM, 38

CDs. See also DVDs.

alternate install. See Installing Ubuntu from

alternate install CD.

copying. See CDs, burning.

desktop. See Installing Ubuntu from 

desktop CD.

installation. See Installation CDs.

playing, 98

ripping, 98

CDs, burning

accessing the burner, 124

Brasero Disc Burner, 125

Burn from Disk Image option, 37

vs. copying, 39

with GNOME, 38

from images, 37–39

installation image files, 37–39

from .iso files, 37, 124–125

with ISO Recorder, 38

Kubuntu, 277–278

in Linux, 38

in Mac OS X, 38

mounting/unmounting devices, 

124–125

with Nero Burning ROM, 38

in Windows, 38

Changing directories, 329

Chats, 79. See also IRC (Internet Relay Chat);

Mailing lists; Ubuntu Forums; Web

forums; Wikis.

chmod command, 333

chown command, 333

Clock, 66, 69–70

Cloud Devices tab, 320

Cloud Folders tab, 320

Cloud storage. See Ubuntu One.

CoC (Code of Conduct), 20–22

Codecs. See also specific codecs.

installing, 95–96

Lubuntu distribution, 306–307

multimedia, 95–97

Ogg Theora, 96

Ogg Vorbis, 96

online resources, 96

supported, list of, 97

video, 99

Collaboration, with Launchpad, 314–315

Collins, Robert, 237

Command line interface. See Terminal.

Commands

help for. See Man pages.

syntax and usage. See specific commands.

Common Appearance and Behavior section,

266

Communicating with developers. See

Ubuntu community, communication

venues.

Community of users. See Ubuntu community.

Compression, multimedia. See Codecs.
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Computer administration

customizing your system. See Customizing.

Kubuntu. See Kubuntu system administra-

tion; Software Management.

troubleshooting. See Troubleshooting system

administration.

Computer Administration section, 266

Computers

older or less powerful. See Installing Ubuntu

from alternate install CD; Xubuntu.

supported by Ubuntu, 34–35

Conferences

developer summits, sprints, and rallies,

222–224

for users, 225–226

Configuring. See also Customizing.

BIOS, 39

keyboard layout. See Keyboard, configuring.

printers. See Printers, configuring.

Unity Launcher, 66–67

Configuring Unity desktop

broadcast preferences, 66

the clock, 70

date and time, 66

keyboard, 66

mouse, 66

power management, 66

screen saver, 66

Connect to Server folder, 66

Contact information

developers and users. See Ubuntu

community, communication venues.

Ubuntu Server, 172

Contacts

managing. See Evolution.

synchronizing with Ubuntu One, 321–322, 324

Containerization, 173

Control Panel, 320–321

Cool Streams, 273

Copying CDs. See CDs, burning.

Copying files and folders

between computers, 66

cp command, 332

File Browser, 92

Copying from CDs. See Ripping CDs.

Copyright violations, music, 273. See also DRM

(Digital Rights Management).

Core philosophical ideals, 17–20

cp command, 332

Crisafulli, Chris, 236

Cropping images, 185

Cunningham, Ward, 217

Customizing. See also Configuring.

the clock, 70

Kubuntu. See Kubuntu system administra-

tion; Kubuntu system settings.

Kubuntu desktop. See Plasma.

look and feel. See Themes and backgrounds.

Cycling through windows, 293–294

Czajkowski, Laura, 236–237

d3lphin. See Dolphin.

Dash, opening, 120–122

Data replication, RAID, 145

Databases, IBM DB2 support, 27

Date and time. See Calendars; Clock.

DB2 database, Ubuntu support, 27

Debian package manager, 156–157

Debian project, 16–17

Decrypting DVDs, 100–101

Degraded mode, RAID, 148

Deleting. See also Removing.

files and folders, 332–333

partitions, 54
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Deleting, continued

user accounts, 123, 336

user groups, 336

delgroup command, 336

Dell laptops, Ubuntu support, 27

deluser command, 123, 166, 336

Democracy vs. meritocracy, 227

Dependencies, identifying, 114

Derivatives of Ubuntu, 30–32

Derived distributions. See also Distributions;

specific distributions.

officially supported, 31, 300.  See also

Edubuntu; Kubuntu; Ubuntu Server.

overview, 30–32

recognized, 31, 36, 304–305.  See also

Kubuntu.

Desktop

KDE. See Plasma.

Kubuntu. See Plasma.

Desktop, Ubuntu. See also Calendars; GNOME;

Unity desktop.

Classic Desktop, 62–63

look and feel. See Themes and backgrounds.

password, 61

Desktop CD, installing from. See Installing

Ubuntu from desktop CD.

Desktop effects, enabling, 207

Desktop folder, 63, 65

Desktop globe, 205

Desktop machines vs. servers, 23–24. See also

Ubuntu Server.

Desktop publishing. See Scribus.

/dev folder, 135

Developer blogs, 75

Developer Membership Board, 236

Developer summits, sprints, and rallies,

222–224

Development discussions. See Blogs; IRC

(Internet Relay Chat); Mailing lists; 

Web forums; Wikis.

Development environment, 285

Device drivers

LIRC (Linux Infrared Control), 101

printers, 126–128

Devices. See specific devices.

df command, 333

Digital cameras, mounting/unmounting, 125

Digital flash cards, 205–206

Digital photography. See Photographs.

Direct binary uploads, 162–163

Directories. See also Folders; Terminal

commands, files and folders.

changing, 329

vs. folders, 131

Disabled users, 20

Disk images. See .iso files.

Disk space usage, displaying, 333

Disk space utility, 103

Disk storage. See CDs; LVM (Logical Volume

Manager); USB storage devices.

across physical boundaries. See RAID

(redundant array of inexpensive

disks).

organizing. See Partitioning disks.

Disk Utility, 103

Display section, 266

Displays. See Monitors; Screens.

Distribution management software, 29

Distributions. See also Repositories; specific

distributions.

bug fixes, 15

contents, 13

definition, 13

derived. See Derived distributions.
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diversity of, 14–16

educational purposes. See Edubuntu.

government of Andalusia, 306

Guadalinex, 306

with KDE. See Kubuntu.

Linux Mint, 306–307

Lubuntu, 307

LXDE (Lightweight X11 Desktop Environ-

ment), 307

for older computers. See Xubuntu.

parents of Ubuntu, 15

with proprietary media codecs, 306–307

tracking changes, 15–16

upgrades, 161–163

Distrowatch database, 14

Docklets, 207

Docky, 206–208

Documentation for Ubuntu, 241. See also Help;

Man pages; Online resources; Ubuntu

community, communication venues.

Documents, creating

desktop publishing. See Scribus.

mathematical expression builder. See Math.

presentations. See Impress.

Scribus, 191–196

spreadsheets. See Calc.

Word Processor, 274

Documents folder, 65

Dollar sign ($), UNIX shell symbol, 327

Dolphin file manager, 270–271

Donating to the Ubuntu project, 30

do-release-upgrade command, 161–163

Dot (.), folder name prefix, 133

Downloading

image files, 249.  See also .iso files.

packages, 157–158

source code, 120

Downloads folder, 65

DPI error, 194

dpkg utility, 156–157

Drag and drop, 93

Draper, Melissa, 236–237

Draw, 274

Drawing programs, 206, 274. See also GIMP;

Inkscape.

Drivers. See Device drivers.

Drives, displaying on the desktop, 63

DRM (Digital Rights Management), 99, 273. See

also Copyright violations.

Drung, Benjamin, 236

Dual boot, partitioning the disk for, 42–46

DVDs. See also CDs.

burners, 38

decrypting, 100–101

Edit Software Sources, 263–264

Editing

graphic images with Scribus, 191

Jokosher, 196–200

movies, 102

music, 196–200

network connections, 69

photographs, 99, 125

PiTiVi, 102

Web pages, 106

Editing text

cat command, 335

gedit Text Editor, 102

with nano editor, 335

Scribus, 191

with sed (Stream EDitor), 335

Edubuntu

downloading, 36

installing. See Installing Edubuntu.
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Edubuntu, continued

overview, 301–303

vs. Ubuntu, 31

Edubuntu Council, 236

Educational applications. See also Games.

activities, enabling/disabling, 200

administration tool, 200

algebra, 206

anagrams, 201

astronomy, 203–204

Blinken, 206

computer use, 206

desktop globe, 205

digital flash cards, 205–206

drawing, 206

factorization, 202

fractions, 202

GCompris, 206

GCompris Administration, 200

geography, 205–206

geometrical constructions, 202

graphing mathematical functions, 203

hangman game, 202

Kalzium, 200–201

Kanagram, 201

KBruch, 202

KHangman, 202

Kig, 202–203

KmPlot, 203

KTouch, 204

KTurtle, 204–205

Logo programming language, 204–205

maps, 205

Marble, 205

math programs, 202, 206

Parley, 205–206

periodic table, 200–201

physics simulator, 206

reading, 206

science, 206

Simon Says game, 206

spelling, 202

Stellarium, 203–204

Step, 206

touch-typing tutorial, 204

Tux Paint, 206

user profiles, 200

world atlas, 205

Education-oriented Ubuntu. See Edubuntu.

Effect filters, 184

E-mail, Evolution

automatically checking for new mail, 82–83

Hotmail, reading, 81

interface, 83

server, specifying, 82

server, unable to connect to, 84

setting up accounts, 80–83

Webmail, reading, 81

Yahoo! Mail, reading, 81

E-mail, Kubuntu, 280–283

Emblems, 93

Empathy, 79

Encrypted swap, 153

encryptfs-setup-swap command, 153

Encryption

disk partitions, 54

files, 152–153

home directory, 152–153

Home folder, 122

user folders, 122

Ending a session. See Logging out.

Erickson, Jordan, 301

/etc folder, 135

Etrich, Matthias, 246–247

Event tracking, Launchpad, 313

Events, Evolution, 84–85
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Evolution, calendar management

appointments, 84–85

enabling, 80–81

events, 84–85

Google calendar, 81

meetings, 84–85

multiple calendars, 85

Evolution, for e-mail

automatically checking for new mail, 82–83

Hotmail, reading, 81

interface, 83

server, specifying, 82

server, unable to connect to, 84

setting up accounts, 80–83

Webmail, reading, 81

Yahoo! Mail, reading, 81

Excel equivalent. See Calc.

ext4 filesystem, 45

Extensions, Firefox, 75–76

Factorization, 202

FAT32 filesystem, 45

Fault tolerance, 149, 152. See also RAID

(redundant array of inexpensive disks).

Favorites list, 254–255

Feature tracking, 29

File Browser. See also File Manager.

default view, 93

drag and drop, 93

sidebar notes, 93

sidebar options, 92–93

starting, 90

tree view, 93

views, changing, 92–93

File Browser, files and folders

annotating folders. See Emblems.

categorizing folders. See Emblems.

copying, 92

displaying files, 91–92

with emblems, listing, 93

folder information, displaying, 93

history, displaying, 93

moving, 92

remote file access, 93–95

selecting, 92

File chooser. See GNOME file chooser.

File management

folder structure, 132

folders vs. directories, 131

Linux folders, list of, 132.  See also specific

folders.

Linux vs. Windows and Mac OS X, 131–133

by location. See File Browser; File Manager;

Kubuntu file management.

Windows folders, accessing from Linux,

133–134

File Manager, 65–66. See also File Browser.

Files. See also Folders.

command-line interface to. See Terminal

commands, files and folders.

contents, viewing, 329

displaying, 91–92

Kubuntu. See Kubuntu file management.

providers, finding, 164

synchronizing with Ubuntu One, 321

Files and folders. See also Folders.

copying, 66, 92, 332

deleting, 332–333

displaying files, 91–92

with emblems, listing, 93

encryption, 152–153

finding, 65–66, 335.  See also File Browser;

File Manager; Finding, files and

folders.

folder information, displaying, 93

in Kubuntu. See Kubuntu file management.
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Files and folders, continued

listing, 328, 333

moving, 92, 332

owners, finding, 164

ownership, changing, 333

permissions, changing, 333

remote file access, 93–95

searching for. See Finding, files and folders.

selecting, 92

typing names, automatic completion, 329

Filesystems

default, 45

ext4, 45

FAT32, 45

optimizing, 56

sharing with Windows, 45

specifying, 56

super-user space, reserving, 56

Ubuntu Server security, 167–168

Fill color, 187–188

Filters, special effects, 184

Financial support for Ubuntu. See Canonical

Ltd.; Ubuntu Foundation.

Finding. See also Search tools; Searching.

files and folders, 65–66, 85–86.  See also File

Browser; File Manager.

packages, 116–117

Firefox

bookmarking Web sites, 74–75

browsing the Web, 73–76

description, 73–74

extensions, 75–76

Flash is missing, 75

Google searches, 74

Kubuntu, 276–277

live bookmarks, 75

navigating the Internet, 73–74

plug-ins, 75–76

search engines, adding, 74

searching, 74

security, downloading extensions, 76

starting, 73

tagging bookmarks, 74

Web searches, 74

Web site, 73

Firewall tables, 170–171

Flash, missing from Firefox, 75

Flash disks, 24

Floppy disks, mounting/unmounting, 125

Folders. See also Files; Files and folders.

with . (dot) prefix, 133

annotating. See Emblems.

categorizing. See Emblems.

changing, 332

command-line interface to. See Terminal

commands, files and folders.

Connect to Server, 66

creating, 333

current, identifying, 331

current, printing, 331

Desktop, 65

vs. directories, 131

Documents, 65

Downloads, 65

files in, listing, 328, 333

finding, 65–66.  See also File Browser; File

Manager.

history, displaying, 93

Home, 65

Linux, list of, 135–136

Music, 65

Network, 66

ownership, changing, 333

permissions, changing, 333

Pictures, 65

Public, 65
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Search for Files, 66

subfolders, definition, 91

synchronizing with Ubuntu One, 320

Templates, 65

typing names, automatic completion, 329

Videos, 65

working, printing, 331

Font selection, 183

“Format the partition” setting, 56

Forum Council, 235

Forums. See Web forums.

Fractions, 202

free command, 333

Free software

access to source code, 5

characteristics of, 4–5

Debian project, 16–17

freedoms, 4–5

history of Ubuntu, 16–17

meaning of “free,” 4–6

vs. open source, 6–7

philosophical goals, 17–20

FREE SPACE line, 54

Freedesktop.org standards, 271

Freedoms of free software, 4–5

FreeNode IRC network, 215–216

The Fridge, 75, 220–221

F-Spot Photo Manager, 125

Full virtualization, 173

Games, 103. See also Educational applications.

Garage Band equivalent. See Jokosher.

Gariépy, Marc, 236, 301

GCompris, 206

GCompris Administration, 200

gedit Text Editor, 102

General chat. See Mailing lists; Wikis.

General Tab, 264

Geographical location, specifying

from alternate install CD, 51–52

from desktop CD, 40–41

Geography application, 205–206

Geometrical constructions, 202

Georgopoulos, Alkis, 236, 301

GHNS (Get Hot New Stuff), 259–260

GIMP (GNU Image Manipulation Program)

creating an image, 182–186

cropping, 185

effect filters, 184

font selection, 183

help, 186

layers, 184–185

moving text, 183

package description, 180–181

starting, 181

templates, 182

text boxes, 183

toilet paper template, 180, 182

tool palette, 183

user interface, 181–182

GIMP Image Editor, 104, 125. See also Inkscape.

Globe application, 286

GNOME, burning CDs/DVDs, 38

GNOME 3, effects on theming, 290

GNOME desktop. See Desktop, Ubuntu.

GNOME file chooser, 85–87

GNOME Shell

changing themes, 296–297

cycling through windows, 293–294

failure to run, 290

GNOME 3, effects on theming, 290

installing, 290

interface, 291

keyboard commands, 295

messages, displaying, 294

minimizing/maximizing windows, 295–296
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GNOME Shell, continued

overlay mode, 292

overview, 290

search capability, 293

shutting off the computer, 295

vs. Unity, 291–294

windows controls, 295–296

GNU project, history of Ubuntu, 4–5

Goals of Ubuntu

accessibility to disabled users, 20

Bug #1, 24–25

CoC (Code of Conduct), 20–22

code modifications, 20

desktop/server support, 23–24

LCoC (Leadership Code of Conduct), 21–22

localization (native language), 19–20

philosophical, 17–20

programming simplicity, 24

technical, 22–24

Gomez, Leandro, 236

Google calendar, 81

Google searches, 74, 272

Gossmeier, Greg, 237

Governance. See Ubuntu community,

governance system.

Government of Andalusia, 306

Graber, Stéphane, 236–237, 301

Gradients, 188–189

Graphics. See Drawing programs; GIMP;

Inkscape.

Graphing mathematical functions, 203

Grawert, Oliver, 237

Greening, Roderick B., 236

grep command, 335. See also zgrep command.

Ground Control, 314–315

Gtranslate, 309

Guadalinex, 306

Guest Session option, 72

Guided—Use Entire Disk... options, 53–54

Gwenview, 285

Gwibber, 79

HAL devices, listing, 334

Handicapped users, 20

Handler, Nathan, 236–237

Hangman game, 202

Hard disks. See Disk space; LVM (Logical

Volume Manager); Partitioning disks.

Hardware. See also specific devices.

detection, from alternate install CD, 52

emulation, 173

listing, 334

Hardware section, 266–268

Hash (#), comment indicator, 156, 158

HBD (Here Be Dragons), 9

Hearing-disabled users, 20

Help. See also Man pages; Online resources;

Technical support; Troubleshooting.

Canonical Ltd., service and support, 26–28

for commands. See man pages.

-help command, 336

images, 186

Inkscape, 191

Scribus, 195

Terminal commands, 331, 336–337

-help command, 336

Helpers, 207

Hibernation mode, disabling, 153

Hikory, Emmet, 236–237

Hill, Benjamin Mako, 341

History of Ubuntu. See also Shuttleworth,

Mark.

Debian project, 16–17

first LTS release, 3

first release, 2

GNU project, 4–5
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Linux, 5

LTS (Long Term Support), 3, 23–24

open source, 6–7

Open Source Initiative, 6

Perens, Bruce, 6

Raymond, Eric S., 6

Stallman, Richard M., 4–5

Torvalds, Linus, 5

Warty Warthog, 2

History of Ubuntu, free software

and the Debian project, 16–17

and GNU, 4–5

meaning of “free,” 4–5

vs. open source, 6–7

Holbach, Daniel, 229

Home directory encryption, 152–153

Home folder

accessing, 63

definition, 65

encrypting, 122

/home folder, 135

/home partition, 143

Hostname, specifying

from alternate install CD, 52

from desktop CD, 48

Hotmail reading with Evolution, 81

Hypervisor, 173–174

Hyphen (-), dash in commands, 329

i386 support, 35

IBM

DB2 database support, 27

virtualization, 173

Icons, 63

IDE (Integrated Development Environment),

285

Ideas and feedback, 240–241

ifconfig command, 334

Image frames, Scribus, 193–194

Image viewer, 285

Images (graphic)

raster graphics. See GIMP.

vector graphics. See Inkscape.

Images (of installation CDs). See .iso files.

Impress, 274

Incremental backups, 135–136

Inkscape. See also GIMP.

drawing a rectangle, 187–188

fill color, 187–188

gradients, 188–189

help, 191

Inkscape: Guide to Vector Drawing Program,

191

online resources, 191

package description, 103–104, 186

PDF format, 189, 191

PNG format, 191

saving, available formats, 189–191

starting, 187

stroke color, 187–188

SVG (Scalable Vector Graphics) format, 189

text, 188–189

tools, 187

Inkscape: Guide to Vector Drawing Program, 191

Installation CDs

alternate install, 34.  See also Installing

Ubuntu from alternate install CD.

burning, 37–39

desktop, 34.  See also Installing Ubuntu from

desktop CD.

downloading, 36–37

.iso files, 37

from Linux, 38

from Mac OS X, 38

mail order, 37

from Windows, 38
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Installation image files. See .iso files.

Installing. See also Software Center.

applications, 72–73

codecs, 95–96

dependencies, identifying, 114

GNOME Shell, 290

packages. See Adding/removing programs

and packages.

packages, Kubuntu, 260–262

Xubuntu, 36

Installing applications. See APT (Advanced

Package Tool); Repositories; specific

applications.

Installing Edubuntu

add-on CD, downloading, 36

online resources, 36

prerequisites, 36

Installing Kubuntu

from the alternate install CD, 249

computer name, configuring, 250

from the desktop CD, 250–253

downloading the image file, 249

keyboard layout, selecting, 250

online resources, 35, 37

partitioning disks, 250

sudo vs. root account, 257

switching from Ubuntu, 249–250

time zone, selecting, 250

Ubiquity installer program, 250–253

username, configuring, 250

Installing Ubuntu

AMD64 support, 35

architectures supported, 34–35

ARM support, 35

backing up data, 40

CDs for. See Installation CDs.

choosing a version, 34–35

i386 support, 35

on a netbook, 31

PowerPC support, 35

from a USB key, 57–58

from Windows, 58

Installing Ubuntu from alternate install CD

geographical location, specifying, 51–52

hardware detection, 52

hostname, specifying, 52

installing a server, 51

keyboard configuration, 47–48

language selection, 51

time zone, setting, 52

user account configuration, 55–56

Installing Ubuntu from alternate install CD,

partitioning the disk

adding partitions, 53–55

“Bootable flag” setting, 56

bootable partitions, specifying, 56

deleting partitions, 54

filesystem, specifying, 56

“Format the partition” setting, 56

FREE SPACE line, 54

Guided—Use Entire Disk... options, 53–54

“Label” setting, 56

labeling partitions, 56

Manual option, 54

mount options, 56

“Mount point” setting, 56

mount points, 56

“Reserved blocks” setting, 56

root partition, creating, 55

settings, 56

“Typical usage” setting, 56

“Use as” setting, 56

Installing Ubuntu from desktop CD

alongside Windows. See Dual boot.

BIOS configuration problems, 39

geographical location specification, 40–41
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getting the CD. See Installation CDs.

hostname, specifying, 48

keyboard configuration, 47–48

language selection, 40

migrating from previous version, 50

password guidelines, 49–50

system use during installation, 51

user account configuration, 46–47

Installing Ubuntu from desktop CD,

partitioning the disk

adding a partition, 45

default filesystem, 45

definition, 42

for dual boot, 42–46

manually, 43–46

mount points, 46

sharing with Windows. See Dual boot.

for Ubuntu only, 43, 44

Installing Ubuntu Server. See also LVM (Logical

Volume Manager); RAID (redundant

array of inexpensive disks).

overview, 142

partitioning, 143–144.  See also RAID.

ssh client, 143

Installing Ubuntu updates

from applications not in repositories,

119–120

Dash, opening, 120–122

downloading source code, 120

launcher, changing, 120–122

multiverse repository, 119

overview, 108–109

PPAs (personal package archives), 120

reviewing update results, 118–119

staying current, 118

universe repository, 119

Instant messaging, 278–279

Internet dial-up tool, 285

iptables command, 170–171

IRC (Internet Relay Chat), 213–216, 279–280

IRC Council, 235–236

IRSSI, 214–215

Isle of Man, 26

.iso files

burning to CDs, 37, 124–125

definition, 37

ISO Recorder, burning CDs/DVDs, 38

iwconfig command, 334

jdong, 235

Joeb454, 235

Jokosher, 196–200

K Control Center. See Software Management,

System Settings.

K3b, 277–278

Kalzium, 200–201

Kamal, Ahmed, 229

Kamarudzzaman, Khairul Aizat, 237

Kanagram, 201

Kate, 284

Kbabel, 309

KBruch, 202

KDE (K Desktop Environment), 246–247. See

also Plasma.

KDevelop, 285

Kernel, checking, 334

Keyboard, configuring, 47–48, 66, 250

Keyboard commands, GNOME Shell, 295

KHangman, 202

Kig, 202–203

Kiosk mode, 283–284

Kioslaves, 272

Kitterman, Scott, 236

Kmail, 281

KMenu, 257–258
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KmPlot, 203

Konqueror file manager, 271–272

Konsole, 284

Kopete, 278–279

KOrganizer, 281–282. See also Calendars.

KPackageKit, 261

KPDF, 285

KPPP, 285

KRandRtray, 286

KRDC, 285

Krumbach, Elizabeth, 237

KSnapShot, 285

KSysGuard, 284

KSystemLog, 285

KTouch, 204

KTurtle, 204–205

Kubuntu

Application Launcher, 254–255

customizing. See Kubuntu system adminis-

tration; Kubuntu system settings.

desktop. See Plasma.

history of, 248–249

installing. See Installing Kubuntu.

K Control Center. See Software Management,

System Settings.

Kdesktop. See Plasma.

logging out, 255–256

navigation, 254–255

overview, 246, 300–301

Project Timelord, 248

Start menu. See KMenu.

vs. Ubuntu, 30–31, 36

Kubuntu applications

3D mapping, 286

Akregator, 282–283

appointment scheduling, 281–282

burning CDs (audio and data), 277–278

Calc, 274

calculator, 274, 284

calendars, 281–282

command line access, 284

Draw, 274

drawing programs. See Draw; GIMP;

Inkscape.

e-mail, 280–283

Favorites list, 254–255

Firefox, 276–277

globe application, 286

Gwenview, 285

IDE (Integrated Development Environment),

285

image viewer, 285

Impress, 274

instant messaging, 278–279

Internet dial-up tool, 285

IRC (Internet Relay Chat), 279–280

K3b, 277–278

Kate, 284

KDevelop, 285

Kiosk mode, 283–284

Kmail, 281

Konsole, 284

Kopete, 278–279

KOrganizer, 281–282

KPDF, 285

KPPP, 285

KRandRtray, 286

KRDC, 285

KSnapShot, 285

KSysGuard, 284

KSystemLog, 285

Marble, 286

Math, 274

meetings, scheduling, 281–282

monitor, rotating and resizing, 286

naming, 254
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Numlock activation, 286

Okular, 285

PDF viewer, 285

Performance Monitor, 284

presentations. See Impress.

Quassel, 280

rekonq, 275–276

remote desktop connection, 285

remote dial-up tool, 285

RSS feeds, tracking, 282–283

running at startup, 286

screen capture program, 285

Speedcrunch, 284

spreadsheets. See Calc.

System Logs Viewer, 285

text editor, 284

Web browsing, 275–277

Web feeds. See RSS feeds.

Word Processor, 274

Kubuntu Council, 236

Kubuntu file management

browsing files, 272

default manager. See Dolphin.

Dolphin file manager, 270–271.  See also

Konqueror.

file structure changes, 271

finding files, 272

freedesktop.org standards, 271

Google searches, 272

kioslaves, 272

Konqueror file manager, 271–272.  See also

Dolphin.

music management, 273–274

shortcuts, 272

split view, 271

USB drive access, 273

Web searches, 272

Windows partition access, 272–273

XDG Base Directory Specification, 271

XDG directories, 271

#kubuntu IRC channel, 215

Kubuntu system administration. See also

Kubuntu system settings; Software

Management.

access rights, changing, 272

Adept. See KPackageKit.

Edit Software Sources, 263–264

installing packages, 260–262

KPackageKit, 261

managing repositories, 263–264

sudo, as a root account, 257

third party software, 263

Kubuntu system settings. See also Kubuntu

system administration; Software

Management, System Settings.

GHNS (Get Hot New Stuff), 259–260

Plasma, 257–259

templates, 259–260

#kubuntu-devel IRC channel, 215

KVM, 173

“Label” setting, 56

Labeling partitions, 56

Lane, Iain, 236

Language selection. See also Translation and

localization.

from alternate install CD, 51

from the desktop CD, 40

during installation, 40, 51

post-installation, 87

Launchers. See Application launchers; specific

launchers.

Launchpad. See also Application launchers.

Answers, 29, 312–313

automatic software builds, 309

Bazaar, 314
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Launchpad, continued

Blueprint Tracker, 28, 311–312

Bugs. See Malone.

bugs, reporting and tracking, 28.  See also

Malone.

collaboration, 314–315

components, 28–29

definition, 28

description, 28

distribution management, 29

event tracking, 313

feature tracking, 29

Ground Control, 314–315

Malone, 28

overview, 307–308

revision control, 314

Rosetta, 28, 309–310

source for installation CDs, 37

Soyuz, 29, 309

specification tracking, 28

support tracking, 29

translation system, 28, 309–310

Layers, images, 184–185

LCoC (Leadership Code of Conduct), 21–22

Legal restrictions, music, 273

less command, 335. See also zless command.

Letters, writing with LibreOffice, 76–78

/lib folder, 135

Libraries, definition, 115

LibreOffice

history of, 76

open file format, 78

saving documents in PDF format, 78

writing a letter with, 76–78

Linux

creating Ubuntu installation CDs, 38

history of Ubuntu, 5

The Linux Documentation Project, 341

Linux Mint, 306–307

Linux User Groups (LUGs). See LoCos (local

community teams).

LinuxCommand.org, 341

Linux-VServer projects, 174

LIRC (Linux Infrared Control), 101

Listing

files, 328, 333

HAL devices, 334

hardware, 334

owned files, 164

packages, 157

USB buses, 334

Live bookmarks, 75

Localization and translation. See also Language

selection.

Gtranslate, 309

Kbabel, 309

Rosetta, 309–310

for Ubuntu, 242

Location. See Geographical location.

Lock Screen option, 71

Locked out of LVM, 153

Locking screens, 71

LoCo Council, 236

LoCos (local community teams), 230–231

Log files, 143

Log Out option, 72

Log tools, 170

Logging out

ending current session, 71–72

Guest Session option, 72

Kubuntu, 255–256

Lock Screen option, 71

locking the screen, 71

Log Out option, 72

Restart option, 72

restarting the computer, 72
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Shut Down option, 72

shutting down, 72

Switch from... option, 72

switching users, 72

Ubuntu, 71–72

Logical Volume Manager (LVM). See LVM

(Logical Volume Manager).

Login Manager, 268

Logo programming language, 204–205

Look & feel, customizing. See Themes and

backgrounds.

Look & Feel section, 265. See also Themes and

backgrounds.

Lopez, Belinda, 237

Lower-power computers, running Ubuntu. See

Installing Ubuntu from alternate install

CD; Xubuntu.

ls command, 328, 333

ls (list files) command, 134

lsb_release -a command, 334

lshal command, 334

lshw command, 334

lspci command, 334

lsusb command, 334

LTS (Long Term Support), 3, 23–24

Lubuntu, 307

LUGs (Linux User Groups). See LoCos (local

community teams).

LVM (Logical Volume Manager). See also RAID

(redundant array of inexpensive disks).

documentation, 154

encrypted swap, 153

encryptfs-setup-swap command, 153

fault tolerance, 152

file encryption, 152–153

getting locked out, 153

hibernation mode, disabling, 153

installer prompts, 153

LVs (logical volumes), 149–150

partition management, 148–150

PEs (physical extents), 150

PVs (physical volumes), 149–150

redundancy, 152

setting up, 150–152

storage fluidity, 152

theory of, 149–150

VGs (volume groups), 149–150

LVs (logical volumes), 149–150

LXDE (Lightweight X11 Desktop Environment),

307

Lye, Matthew, 237

Mac OS X, creating Ubuntu installation CDs, 38

Macromedia Flash. See Flash.

Magnatune store, 273

Mahjongg, 103

Mailing lists, 212–213

Main repository, 155, 263

Malone, 28, 310–311

Malone, Bugsy, 310

man command, 331, 336–337

man files, searching for, 337

man intro command, 337

man -k command, 337

man man command, 337

man pages. See also Help.

accessing, 331

Terminal commands, 331, 336–337

Mangold, Christian, 236

Manual option, 54

Manually partitioning disks

with an alternate install CD, 54

with a desktop CD, 43–46

Maps, 205

Marble, 205, 286

Math, 274
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Math programs, 202, 206

Maximizing/minimizing windows

applications, 63–64

GNOME Shell, 295–296

/media folder, 135

Meetings, scheduling. See also Calendars.

Evolution, 84–85

Kubuntu, 281–282

Membership Approval Boards, 237

Memory usage, displaying, 333

Meritocracy vs. democracy, 227

Messages, displaying, 294

Microsoft, as Bug #1, 24–25

Migrating from previous version, 50. See also

Installing Ubuntu updates.

Minimizing/maximizing windows

applications, 63–64

GNOME Shell, 295–296

MIT, virtualization, 174

mkdir command, 333

/mnt folder, 135

Mobile devices, for Ubuntu One, 319

Monitors. See also Screens.

corner features, 71

rotating and resizing, 286

Morgan, Mackenzie, 236–237

MOTUs (Masters of the Universe), 231–232

Mount options, 56, 168

“Mount point” setting, 56

Mount points, partitioning disks

with an alternate install CD, 56

with a desktop CD, 46

Mounting/unmounting devices

automatically, 123

burning CDs, 124–125

description, 123

digital cameras, 125

floppy disks, 125

folder for, 135

listing mounted devices, 123

troubleshooting, 123

USB keyrings, 124

Mouse, configuring, 66

Movement-disabled users, 20

Movie Player, 99–101

Movies, editing, 102. See also Videos.

Moving

files and folders, 92, 332

between virtual desktops, 70

Mozilla Web site, 73

Multimedia codecs. See Codecs.

Multiverse repository, 119, 155, 263

Music. See also Audio.

Amarok music manager, 273–274

Audio CD Extractor, 106–107

buying, 98–99

Cool Streams, 273

copyright violations, 273

DRM (Digital Rights Management), 99, 273

Jamendo, 98

legal restrictions, 273

Magnatune, 98

Magnatune store, 273

managing, 273–274

online radio, 273

online stores, 273

portable players, managing, 273

recording, 103, 196–200

Shoutcast Streams, 273

Ubuntu One Music Store, 98–99

Music folder, 65

mv command, 332

My Documents, Ubuntu equivalent, 65

Mythbuntu, 305
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nano command, 335

nano text editor, 335

Nautilus. See File Browser.

Nero Burning ROM, burning CDs/DVDs, 38

Netbook Edition, 31

Netbook Remix. See Netbook Edition.

Network & Connectivity section, 266

Network folder, 66

Network interface report, 334

Network Manager, 69

Network Neighborhood, Ubuntu equivalent, 66

Network Places, Ubuntu equivalent, 66

Networks

connection information, viewing, 69

editing connections, 69

enabling/disabling, 69

notifications, enabling/disabling, 69

New Printer Wizard, 127–129

No open ports policy, 165

noatime option, 168

nodev option, 167

noexec option, 167

Nogueira, Duda, 237

nosuid option, 167

Note taking application, 70

Notes, synchronizing with Ubuntu One,

322–323

Notification area, 68–69

Notifications, enabling/disabling, 69

Numlock activation, 286

Office suite. See LibreOffice.

Official members of Ubuntu, 238–239

The Official Ubuntu Server Book, 171, 341

Ogg Theora, 96

Ogg Vorbis, 96

Okular, 285

Older computers, running Ubuntu. See

Installing Ubuntu from alternate install

CD; Xubuntu.

Online radio, 273

Online resources. See also Help.

BIOS manual, 39

bulletin boards. See IRC (Internet Relay

Chat); Mailing lists; Wikis.

community participation, 287

development discussions. See Blogs; IRC

(Internet Relay Chat); Mailing lists;

Web forums; Wikis.

Docky, 207

Firefox extensions, 75

The Fridge, 75

grep tutorials, 335

installation CDs, 36–37

IRC (Internet Relay Chat), 213–216

Jokosher, 200

Kubuntu, installing, 35

Kubuntu wiki, 287

Launchpad, 37

The Linux Documentation Project, 341

LinuxCommand.org, 341

mailing lists, 212–213

online events, 239

Planet Ubuntu, 75

Scribus, 195

sed tutorials, 335

social media, 222

text files, searching and editing, 335

Ubuntu derivatives, 30–32

Ubuntu developer blogs, 75

Ubuntu Server security, 172

Xubuntu, installing, 36

Online services, integrating, 79

Online stores, 273
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Open file format, 78

Open source

history of, 6–7

philosophical goals, 19

Open Source Initiative, 6

OpenOffice.org. See LibreOffice.

OpenVZ, 174

Operating systems. See specific operating systems.

emulating. See Ubuntu Server virtualization.

running within operating systems. See

Ubuntu Server virtualization.

/opt folder, 135

OS virtualization, 173

Other permission, 167

Overlay mode, GNOME Shell, 292

Owner permission, 167

Ownership, changing, 333

Package management. See also APT (Advanced

Package Tool); MOTUs (Masters of the

Universe); Synaptic; Technical Board;

Ubuntu archive.

adding/removing programs and packages,

115–117

APT sources, 155–157

apt-cache utility, 158–159

apt-get utility, 158–159

aptitude utility, 163–164

build queue approach, 162–163

building packages from source, 162–163

Debian package manager, 156–157

default packages, 143

direct binary uploads, 162–163

distribution upgrades, 161–163

do-release-upgrade command, 161–163

downloading packages, 157–158

dpkg utility, 156–157

file owner, finding, 164

file provider, finding, 164

installing packages, 157–158, 160

listing owned files, 164

listing packages, 157

malicious packages, 157–158

package information, displaying, 159–160

patches, applying, 161

removing packages, 160, 162

repositories, 154–157

searching for packages, 159–160

security, 157–158, 161

system updates, with apt-get, 158–159

third-party packages, 157–158

Packages

adding/removing. See Adding/removing

programs and packages.

building from source, 162–163

default, 143

definition, 114

downloading, 157–158

finding, 116–117.  See also Repositories;

Software Center.

information, displaying, 159–160

installing, 116

locations. See Repositories.

malicious, 157–158

removing, 116

searching for, 159–160

software channels. See Repositories.

Packaging Ubuntu distributions, 242–243

Panel manager. See GNOME shell.

Paravirtualization, 173

Parity drives, 146

Parley, 205–206

Partition security, 143

Partitioning disks, alternate install CD

adding partitions, 53–55

“Bootable flag” setting, 56
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bootable partitions, specifying, 56

deleting partitions, 54

encryption, 54

filesystem, specifying, 56

“Format the partition” setting, 56

FREE SPACE line, 54

Guided—Use Entire Disk... options, 

53–54

“Label” setting, 56

labeling partitions, 56

Manual option, 54

manually, 54

mount options, 56

“Mount point” setting, 56

mount points, 56

“Reserved blocks” setting, 56

root partition, creating, 55

settings, 56

sizing partitions, 55

“Typical usage” setting, 56

“Use as” setting, 56

Partitioning disks, desktop CD

adding a partition, 45

default filesystem, 45

definition, 42

for dual boot, 42–46

manually, 43–46

mount points, 46

Partitioning disks, Kubuntu, 250

Partitions

Ubuntu Server security, 143

Windows, 133–134, 272–273.  See also

Dual boot.

passwd command, 336

Passwords. See also Security.

bypassing, 67

changing, 67, 257, 336

desktop login, 61

guidelines for creating, 49–50

randomly generated, 67

as a series of *s, 61

Ubuntu One, 321

user accounts, selecting, 49–50

Paul Tagliamonte, 236

PDF (Portable Document Format)

exporting from Scribus, 194–195

Inkscape, 189, 191

saving from LibreOffice, 78

PDF viewer, 285

Pen disks, 24

Penelope Stowe, 237

Perens, Bruce, 6

Performance Monitor, 284

Performance monitoring, 103

Periodic table, 200–201

Permissions. See also sudo command;

Superusers.

changing, 333

files, 333

Kubuntu, 272

Software Management, 268

Ubuntu Server security, 167–168

Persistence, USB storage devices, 57–58

Personal section, 265

PEs (physical extents), 150

Philosophical goals of Ubuntu, 17–20

Photographs, managing

F-Spot Photo Manager, 125

GIMP Image Editor, 125

Shotwell, 99

Photoshop. See GIMP.

Physical drive failure, 148

Physical storage, moving. See LVM (Logical

Volume Manager).

Physics simulator, 206

Pictures. See Drawing; Photographs.
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Pictures folder, 65

Pidgin, 214

PIM (personal information manager). See

Evolution.

Pipe symbol (|), 134–135

Pipelines, 134–135, 329–330

PiTiVi, 102

Planella, David, 229

Planet Ubuntu blogs, 75

Plasma, 257–259

Plug-ins, Firefox, 75

PNG format, Inkscape, 191

Podcasts, listening to, 98

Pope, Alan, 236–237

Portable music players, managing, 273

POSIX model, Ubuntu Server security, 167

Power Control section, 266

Power management, configuring, 66

PowerPC support, 35

PowerPoint equivalent. See Impress.

PPAs (personal package archives), 120

A Practical Guide to Linux® Commands...,

341

Preferences. See Configuring; Customizing;

Kubuntu system settings; Software

Management, System Settings.

Prerequisites for installing software. See

Dependencies.

Printer Configuration section, 267

Printers

configuring, 126–131, 266–268

printing a test page, 129–130

remote printing, 130

Printing

system information, 334

version information, 334

working directory, 331

Private messaging, 214

Privileges. See Permissions.

Problems

reporting. See Launchpad; Malone.

solving. See Technical support; 

Troubleshooting.

Process information, displaying, 334

Processes, viewing, 334

/proc/sys folder, 135

Production studio, 105

Programming for Ubuntu, 242–243

Programs

adding. See Installing.

application. See Applications.

emulating. See Ubuntu Server 

virtualization.

operating systems. See specific 

operating systems.

packaged for installation. See Packages.

running within operating systems. See

Ubuntu Server virtualization.

Project Timelord, 248

ps command, 334

Public folder, 65

PVs (physical volumes), 149–150

pwd command, 331

Python language, 24

q command, 337

QEMU, 173

Quality assurance, 242

Quassel, 280

Question mark (?), wildcard character, 338

Radio, online, 273

RAID (redundant array of inexpensive disks)

array failure, 148

array management. See LVM (Logical 

Volume Manager).

366 Index



backing up data, 147

choosing, 146

data replication, 145

degraded mode, 148

documentation, 154

fault tolerance, 149, 152

levels, 145–146

modes, 146

overview, 144–145

parity drives, 146

physical drive failure, 148

RAID 0, 145

RAID 1, 145

RAID 5, 145

setting up, 146–148

space requirements, 145

spare devices, 148

striped set, 145

RAID 0, 145

RAID 1, 145

RAID 5, 145

Rankin, Kyle, 341

rar backup program, 136

Raster graphics. See GIMP.

Raymond, Eric S., 6

Reading application, 206

Recording

music, 103, 196–200

sounds, 103

Rectangle, drawing, 187–188

Redundancy, 152

Redundant array of inexpensive disks (RAID).

See RAID (redundant array of

inexpensive disks).

rekonq, 275–276

Releases. See also specific releases.

first, 2

LTS (Long Term Support), 3, 23–24

new, updating to. See Installing Ubuntu

updates.

scheduling goals, 22–23

support duration, 23

Reminders. See Calendars.

Remote control, 101

Remote desktop connection, 285

Remote dial-up tool, 285

Removing. See also Deleting.

programs. See Adding/removing programs.

user accounts, 336

user groups, 336

Reporting bugs. See Malone.

Repositories, 114, 154–157. See also APT

(Advanced Package Tool); Ubuntu

archive.

Repository management, 263–264

Requirements for installing software. See

Dependencies.

“Reserved blocks” setting, 56

Restart option, 72

Restarting the computer, 72

Restoring. See Maximizing/minimizing.

Restricted repository, 155, 263

Revision control, 314

Riddell, Jonathan, 236, 248

Ripping CDs

Audio CD Extractor, 106–107

overview, 98

Sound Juicer, 106–107

rm command, 332–333

Root account, enabling, 152–153

/root folder, 135

Root partition, creating, 55

Rosetta, 28, 309–310

RSS feeds, tracking, 282–283

rsync backup program, 136

Rubin, David, 237
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SABDFL (self-appointed benevolent dictator

for life), 237–238

Sauthier, Christophe, 236

/sbin folder, 135

Schedule management. See Evolution.

Scheduling events. See Calendars.

Schools, Ubuntu for. See Edubuntu.

Schultink, Jussi, 236

Screen capture program, 285

Screens. See also Monitors.

corner features, 71

locking, 71

multiple, 338–340

Screensavers, configuring, 66, 89–90

Scribus. See also LibreOffice.

creating a document, 191–196

exporting to PDF, 194–195

help, 195

online resources, 195

package description, 105–106, 188

saving to SLA format, 195

user interface, 107

Scribus, graphic images

DPI error, 194

editing, 191

image frames, 193–194

inserting, 193–194

supported formats, 193

Scribus, text

adding, 192

editing, 191

overflowing the frame, 193

text frames, 192

Word documents, importing, 192

Search for Files folder, 66

Search tools. See also Finding.

desktop search box, 74

Firefox, 74

Searching

for files and folders. See Finding, files and

folders.

in Firefox, 74

in GNOME Shell, 293

for man files, 337

for packages, 159–160

Security. See also Passwords.

Firefox extensions, 76

locking the screen, 71

Ubuntu Server. See Ubuntu Server security.

sed (Stream EDitor), 335

sed command, 335

Selecting files and folders, 92

Self-appointed benevolent dictator for life

(SABDFL), 237–238

Semantic Desktop, enabling, 270

Sending messages. See E-mail; IRC (Internet

Relay Chat); Mailing lists; Wikis.

Servers

connecting to, 66

vs. desktop machines, 23–24.  See also

Ubuntu Server.

installing from alternate install CD, 51

Service and support. See Technical support.

Service Manager section, 269

Services, synchronizing with Ubuntu One, 320

Services tab, 320

Settings, partitioning disks, 56

Shortcuts, Kubuntu, 272

Shotwell, 99

Shoutcast Streams, 273

Shut Down option, 72

Shutting down, 72, 295. See also Logging out.

Shuttleworth, Mark. See also History of Ubuntu.

Bug #1, 24–25

companies founded by, 8–9.  See also

Canonical Ltd.
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profile, 7–9

SABDFL (self-appointed benevolent dictator

for life), 237–238

space travel, 8

starting Ubuntu, 2

Warthogs, 9–10

Sidebar notes, 93

Sidebar options, 92–93

Silber, Jane, 26

Siltala, Juha, 236

Simon Says game, 206

Simpson, Terrence, 236

Sitter, Harald, 236

SLA format, saving from Scribus, 195

Slackware, 14–15

SLS (Softlanding Linux System), 14

Sobell, Mark G., 341

Social networking. See Ubuntu community,

communication venues.

Software

installing. See Adding/removing programs

and packages; Installing.

upgrades, installing. See Installing Ubuntu

updates.

Software Center, adding/removing programs

and packages, 112–114

Software channels, 114. See also Repositories.

Software Management. See also Kubuntu system

administration.

adding/removing programs, 260–263

KPackageKit, 261

main repository, 263

managing repositories, 263

multiverse repository, 263

password, changing, 257

restricted repository, 263

third-party repositories, 263

universe repository, 263

Software Management, System Settings. See also

Kubuntu system settings.

access rights, changing, 268

Add or Remove Software section, 267

Advanced tab, 264, 267

Advanced User Settings section, 269–271

Common Appearance and Behavior section,

266

Computer Administration section, 266

Display section, 266

General Tab, 264

Hardware section, 266–268

Login Manager, 268

Look & Feel section, 265

Network & Connectivity section, 266

overview, 264–265

Personal section, 265

Power Control section, 266

printer configuration, 266–268

Printer Configuration section, 267

Semantic Desktop, enabling, 270

Service Manager section, 269

System section, 267

update notification, 264

upgrading Kubuntu, 264

User Manager, 268

users, creating, 268

Workspace Appearance and Behavior section,

266

Software stores. See Repositories.

Somerville, Cody A.W., 236

Sound cards, mixer settings, 69

Sound Juicer, 106–107

Sound Recorder, 103

Sounds, recording, 103. See also Audio; Music.

Source code, free access to, 5

Soyuz, 29, 309

Specification tracking, 28
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Speedcrunch, 284

Spelling, 202

Spillner, Josef, 259

Spin-offs from Ubuntu, 30–32

Split view, 271

Spools, 143

Stallman, Richard M., 4–7

Starting

applications, 63–64, 73

Firefox, 73

Terminal, 327–328

Stellarium, 203–204

Step, 206

Stick disks, 24

Storage, physically moving. See LVM (Logical

Volume Manager).

Storage capacity, Ubuntu One, 319

Storage fluidity, 152

Stream EDitor (sed), 335

Striped sets, RAID, 145

Stroke color, 187–188

Subprojects of Ubuntu, 30–32

sudo command

as Kubuntu root account, 257

superuser privileges, 330–331

Ubuntu Server security, 154, 166–167

sudoers database, 166–167

Sudoku, 103

Sun Microsystems, virtualization, 174

Superusers

reserving space for, 56

running Terminal commands, 330–331

software folder, 135

Support. See Technical support.

Support tracking, 29

SVG (Scalable Vector Graphics), 103–104, 189.

See also Inkscape.

Switch from... option, 72

Switching

applications, 70

between applications, 70

from Ubuntu to Kubuntu, 249–250

users, 72

workspaces, 70

Synaptic, 115–117

Synchronizing with Ubuntu One

bookmarks, 323

contacts, 321–322, 324

files, 321

managing, 320

notes, 322–323

selecting folders for, 320

for specific services, 320

Ubuntu One address book, 322

System administration

customizing your system. See Customizing.

Kubuntu. See Kubuntu system administra-

tion; Software Management.

troubleshooting. See Troubleshooting system

administration.

System information

command-line interface to. See Terminal

commands, system information.

printing, 334

System log files. See Log files.

System Logs Viewer, 285

System Monitor, 103

System problems, troubleshooting. See

Troubleshooting.

System resource limits, 168–169

System section, 267

System settings, Kubuntu. See Kubuntu system

settings; Software Management, System

Settings.
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Tagging bookmarks, 74

tail utility, 170

Takdir, Muhammad, 237

Taskbar, 63

Teams. See Ubuntu community teams.

Technical Board, 234–235

Technical goals of Ubuntu, 22–24

Technical support. See also Bugs, reporting and

tracking; Help; Online resources;

Troubleshooting; Ubuntu community,

communication venues.

Canonical Ltd., 26–28

LTS (Long Term Support), 3, 23–24

tracking, 29

Technoviking, 235

Templates

GIMP, 182

Kubuntu, 259–260

Templates folder, 65

Terminal

description, 103, 134–135

Kubuntu, 284

starting, 327–328

window, illustration, 328

Terminal commands

&& (ampersands), running commands

conditionally, 338

* (asterisk), wildcard character, 338

@ (at sign), in command-line username, 

327

$ (dollar sign), UNIX shell symbol, 327

- (hyphen), dash in commands, 329

? (question mark), wildcard character, 338

| (vertical bar), pipe symbol, 134–135, 329

[ ] (brackets), wildcard characters, 338

[!] (brackets, exclamation point), wildcard

characters, 338

; (semicolon), running commands

sequentially, 338

~ (tilde), home directory indicator, 327

documentation. See Man pages.

executing multiple, 338

help, 331

-help, 336

ls (list files) command, 134

man pages, accessing, 331

passing output. See Pipelines.

pipelines, 134–135, 329–330

A Practical Guide to Linux® Commands..., 341

printing system or version information, 334

q, 337

quitting to the command prompt, 337

running as a superuser, 330–331

running sequentially, 338

stringing together. See Pipelines.

sudo, 330–331

wildcards, 337–338

Terminal commands, files and folders

cat, 329, 335

cd, 329, 332

changing directories, 329

changing folders, 332

chmod, 333

chown, 333

contents, viewing, 329

copying, 332

cp, 332

creating folders, 333

current folder, identifying, 331

deleting, 332–333

grep, 335

less, 335

listing, 328, 333

ls, 328, 333
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Terminal commands, continued

mkdir, 333

moving, 332–333

mv, 332

nano, 335

ownership, changing, 333

permissions, changing, 333

printing working directory, 331

pwd, 331

rm, 332–333

sed, 335

text files, searching and editing, 335

Terminal commands, system information

df, 333

disk space usage, displaying, 333

free, 333

HAL devices, listing, 334

hardware, listing, 334

ifconfig, 334

iwconfig, 334

kernel, checking, 334

lsb_release -a, 334

lshal, 334

lshw, 334

lspci, 334

lsusb, 334

memory usage, displaying, 333

network interface report, 334

process information, displaying, 334

processes, viewing, 334

ps, 334

top, 334

uname -a, 334

USB buses, listing, 334

version information, printing, 334

wireless network information, displaying,

334

Terminal commands, users and groups

addgroup, 336

delgroup, 336

deluser, 336

groups, adding/removing, 336

passwd, 336

passwords, changing, 336

user accounts, adding/removing, 336

users logged on, displaying, 336

who, 336

Text

on images, moving, 183

Inkscape, 188–189

Scribus, 191–193

Text boxes on images, 183

Text editors

Kate, 284

nano, 335

sed (Stream EDitor), 335

Text files, searching and editing, 335

Text frames, Scribus, 192

Thawte, founding of, 8

The Shuttleworth Foundation (TSF), 8–9

Themes and backgrounds

effects of GNOME 3, 290

GNOME Shell, 296–297

Kubuntu. See Plasma.

screensavers, 89–90

Ubuntu, 88–90

Third party software, 263

Thomas, Jonathan, 236

3D mapping, 286

3D modeling, 105

Tilde (~), home directory indicator, 327

Time and date. See Clock.

Time zone, selecting, 52, 250

/tmp partition, 143
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To-do lists. See Evolution.

Toilet paper template, 180, 182

Tomboy Notes, 70, 322–323

top command, 334

Torvalds, Linus, 5

Touch-typing tutorial, 204

Tracking

bugs. See Bugs, reporting and tracking;

Launchpad; Malone.

distribution changes, 15–16

specifications, 28

support, 29

system features, 28

Translation and localization, 242. See also

Rosetta.

Trash (wastebasket), 70

Troubleshooting. See also Technical support.

BIOS configuration problems, 39

GNOME Shell fails to run, 290

mounting/unmounting devices, 123

problem reporting. See Launchpad; Malone.

Troubleshooting system administration

command options, help for. See man pages.

copying files between computers, 66

help for commands. See man pages.

Trudel-Lapierre, Mathieu, 237

TSF (The Shuttleworth Foundation), 8–9

Tutu, Desmond, 11

Tux Paint, 206

“Typical usage” setting, 56

Ubiquity installer program, 250–253

Ubunteros, 238–239

Ubuntites. See Ubunteros.

Ubuntu

CoC (Code of Conduct), 20–22

definition, 12

derivatives. See Derived distributions.

desktop. See Desktop, Ubuntu.

developer blogs, 75

for educational environments. See Edubuntu.

financial support for. See Canonical Ltd.;

Ubuntu Foundation.

history of. See History of Ubuntu.

for KDE (K Desktop Environment). See

Kubuntu.

LCoC (Leadership Code of Conduct), 21–22

for multimedia production. See Ubuntu

Studio.

on older computers. See Xubuntu.

spin-offs, 30–32

subprojects, 30–32

technical goals, 22–24

for use in schools. See Edubuntu.

word origin, 10–11

for Xfce window management system. See

Xubuntu.

Ubuntu archive, 155. See also Ubuntu Server

package management.

Ubuntu community

activists. See Ubunteros.

advocacy, 240

artwork, 241

bug tracking, 242

CoC (Code of Conduct), 20–22

documentation, 241

giving back to, 287

ideas and feedback, 240–241

LCoC (Leadership Code of Conduct), 21–22

localization, 242

official members, 238–239

online events, 239

packaging, 242–243

philosophical goals, 17–20
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Ubuntu community, continued

programming, 242–243

quality assurance, 242

support, 240

translation, 242

Ubuntu community, communication venues

bulletin board. See The Fridge.

development discussions. See IRC (Internet

Relay Chat); Mailing lists; Wikis.

The Fridge, 75

general chat. See IRC (Internet Relay Chat);

Mailing lists; Wikis.

Planet Ubuntu blogs, 75

support-oriented. See IRC (Internet Relay

Chat); Mailing lists; Wikis.

Ubuntu community, governance system. See

also Canonical Ltd.; Ubuntu community

teams; Ubuntu Foundation.

activists. See Ubunteros.

Developer Membership Board, 236

Edubuntu Council, 236

Forum Council, 235

IRC Council, 235–236

Kubuntu Council, 236

LoCo Council, 236

Membership Approval Boards, 237

meritocracy vs. democracy, 227

SABDFL (self-appointed benevolent dictator

for life), 237–238

Technical Board, 234–235

Ubuntites. See Ubunteros.

Ubuntu community teams

at Canonical, 229–230

cloud community, 230

creating and dissolving, 233

developer community, 230

LoCos (local community teams), 

230–231

meritocracy, 227

MOTUs (Masters of the Universe), 231–232

overview, 228–229

team councils, 232–234

translation community, 230

Ubuntu Developer Membership Board, 236

Ubuntu Forum Council, 235

Ubuntu Forums, 136

Ubuntu Foundation

CoC (Code of Conduct), 20–22

description, 29–30

geographical location, 29

LCoC (Leadership Code of Conduct), 

21–22

philosophical goals, 17–20

#ubuntu IRC channel, 215–216

Ubuntu IRC Council, 235–236

Ubuntu LoCo Council, 236

Ubuntu Membership Approval Boards, 237

Ubuntu Netbook Edition, 31

Ubuntu Netbook Remix. See Netbook Edition.

Ubuntu One

account management, 320

Account tab, 320

address book, synchronizing with Ubuntu

One, 322

Cloud Devices tab, 320

Cloud Folders tab, 320

Control Panel, 320–321

cost, 318

current usage, displaying, 320

description, 79

getting started, 318–321

for mobile devices, 319

password, 321

Services tab, 320

storage, 319

uses for, 318
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Ubuntu One, synchronizing

bookmarks, 323

contacts, 321–322, 324

files, 321

managing, 320

notes, 322–323

selecting folders for, 320

for specific services, 320

Ubuntu One Mobile, 319, 324

Ubuntu One Music Store, 98–99

Ubuntu Server

/home partition, 143

installing. See Installing Ubuntu Server.

The Official Ubuntu Server Book, 341

overview, 140–142, 303

partition security, 143

/tmp partition, 143

vs. Ubuntu, 35–36

/var partition, 143

Ubuntu Server package management. See also

APT (Advanced Package Tool); Ubuntu

archive.

apt-get utility, 158–159

aptitude utility, 163–164

system updates, with apt-get, 158–159

Ubuntu Server security. See also Security.

adduser command, 166

administrator account, 153–154

contact information, 172

deluser command, 166

filesystems, 167–168

firewall tables, 170–171

group permission, 167

home directory encryption, 152–153

iptables command, 170–171

log files, 143

log tools, 170

mount options, 168

no open ports policy, 165

noatime option, 168

nodev option, 167

noexec option, 167

nosuid option, 167

The Official Ubuntu Server Book, 171

online resources, 172

other permission, 167

overview, 165

owner permission, 167

partitions, 143

permissions, 167–168

POSIX model, 167

root account, enabling, 152–153

spools, 143

sudo command, 154, 166–167

sudoers database, 166–167

system resource limits, 168–169

tail utility, 170

user account administration, 165–167

visudo command, 166

zcat utility, 170

zgrep utility, 170

zless utility, 170

Ubuntu Server virtualization

Bochs, 173

common hardware emulators, 173

containerization, 173

definition, 172

full virtualization, 173

hardware emulation, 173

hypervisor, 173–174

IBM, 173

KVM, 173

Linux-VServer projects, 174

MIT, 174

OpenVZ, 174

OS virtualization, 173
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Ubuntu Server virtualization, continued

paravirtualization, 173

preferred solution, 174

QEMU, 173

Sun Microsystems, 174

types of, 173–174

VirtualBox, 174

VMware, 172

Xen, 174

XVM, 174

xVM, 174

zoning, 173

z/VM, 173

Ubuntu Software Center. See Software 

Center.

Ubuntu Studio, 304–305

#ubuntu+1 IRC channel, 216

ubuntu-announce mailing list, 213

#ubuntu-devel IRC channel, 221

ubuntu-devel IRC channel, 215–216

ubuntu-devel mailing list, 213

ubuntu-devel-discuss mailing list, 213

#ubuntu-offtopic IRC channel, 216

uname -a command, 334

UNetbootin, 57

Uninstalling. See Removing.

Unity desktop

application icons, 63

buttons, 63–64

clock, 69–70

corner features, 71

customizing the clock, 69–70

Desktop folder, 65

device icons, 63

vs. GNOME Shell, 291–294

Home folder, 65

locking the screen, 71

logging in, 61

My Documents, equivalent, 65

Network Neighborhood, equivalent, 65

Network Places, equivalent, 65

notification area, 68–69

servers, connecting to, 66

taskbar, 63

trash, 70

usability, 71

virtual desktops, 70

volume control, 69

Windows system tray, equivalent, 

68–69

workspaces, 70

Unity desktop, applications

closing, 63

maximizing, 64

minimizing, 63

starting, 63–64

Unity Launcher. See also Application 

launchers.

adding users and groups, 67–68

configuring your system, 66–67

finding files and folders, 65–66

minimizing/restoring applications, 64

open applications, displaying, 70

starting applications, 63–64

switching workspaces, 70

workspaces, displaying, 70

Universe repository, 119, 155, 263

Unmounting a device. See

Mounting/unmounting devices.

Update Manager, 108–109

Updating Kubuntu, 264

Upgrading Ubuntu. See Installing Ubuntu

updates.

Usability, 71
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USB drive access, 273

USB keyrings, mounting/unmounting, 124

USB storage devices

buses, listing, 334

installing Ubuntu from, 57–58

making bootable, 57

persistence, 57–58

“Use as” setting, 56

User account administration, 165–167

User accounts

adding, 67–68, 122–123, 336

changing, 67–68

default type, 122–123

deleting, 123, 336

deluser command, 336

groups. See User groups.

hostname, specifying, 48

passwords, selecting, 49–50, 56

system administration privileges, 67

usernames, for new user accounts, 48–49,

55–56

User accounts, configuring

from alternate install CD, 55–56

from desktop CD, 46–47

User community. See Ubuntu community.

User conferences, 225–226

User groups

addgroup, 336

adding, 67–68

adding/removing, 336

delgroup, 336

permissions, 167

User Manager, 268

Usernames

in command lines, 327

configuring, 250

for new user accounts, 48–49, 56

Users

adding, 67–68

creating, 268

logged on, displaying, 336

/usr folder, 135

/var folder, 135

/var partition, 143

Vector graphics. See SVG (Scalable Vector

Graphics).

Vendor lock-in, 78

Verisign, 8

Version, choosing for installation, 34–35

Version control tool, 28–29

Version information, printing, 334

Vertical bar (|), pipe symbol, 134–135, 329

VGs (volume groups), 149–150

Videos. See also Movies.

creating, 102

watching, 99–101

Videos folder, 65

Virtual company, 11–12

Virtual computer. See Dual boot; Ubuntu Server

virtualization.

Virtual desktops, 70

VirtualBox, 174

Virtualization. See Ubuntu Server virtualiza-

tion.

Visual themes. See Themes and backgrounds.

Visually-disabled users, 20

visudo command, 166

VMware, 172

Volkerding, Patrick, 14

Volume control, 69

Wallpaper. See Themes and backgrounds.

Warthogs, 2, 9–10
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Warty Warthog, 2

Wastebasket (trash), 70

Web browsers. See also Firefox.

Konqueror file manager, 271–272

rekonq, 275–277

Web feeds. See RSS feeds.

Web forums, 216–217. See also Ubuntu

Forums.

Web searches, 272

Web sites

automatic content retrieval, 75

bookmarks, 74–75

browsing. See Firefox; Konqueror.

Webmail, reading with Evolution, 81

who command, 336

Wikis, 217–221

Wildcards, 337–338

Window manager, alternatives. See GNOME

shell.

Windows

creating Ubuntu installation CDs, 38

emulation, 136–137

filesystem, vs. Linux, 131–133

installing Ubuntu from, 58

sharing filesystems with Ubuntu, 45

Ubuntu compatibility, 136–137

Windows

cycling through, GNOME Shell, 293–294

minimizing/maximizing, GNOME Shell,

295–296

Windows controls, GNOME Shell, 295–296

Windows Installer, 58

Windows partitions. See Partitions, Windows.

Wine Windows Emulator, 136–137

Wireless network information, displaying, 334

Word, Ubuntu equivalent. See Word Processor.

Word documents, importing into Scribus, 192

Word Processor, 274

Working directory, printing, 331

Workspace Appearance and Behavior section,

266

Workspaces, 70

Writer. See Word Processor.

Writing letters with LibreOffice, 76–78

Wubi, 58

XChat-gnome, 214

XDG Base Directory Specification, 271

XDG directories, 271

Xen, 174

Xubuntu, 31, 36, 304

XVM, 174

xVM, 174

Yahoo! Mail, reading with Evolution, 81

zcat command, 170. See also cat command.

zgrep command, 170. See also grep command.

ZhengPeng Hou, 237

zless command, 170. See also less command.

Zoning, 173

z/VM, 173
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